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halve the size of your backups”
iCloud is the one Apple service guaranteed to start a 
debate. Some love the way it connects all of your 
devices; others say it’s plagued with bugs or that they 
simply don’t trust it. We ran our own readers’ survey, 
studied the results and thought it was about time that 
debate was laid to rest. Our 50 Critical iCloud Tricks & 
Fixes cover feature sets out to do just that by showing 
you how to master Mail, Calendar & Contacts, unlock 
more free storage and even halve the size of your 
backups. It’s essential reading for anyone who uses 
Apple’s cloud service.

With Oscar season in full swing, our iMovie 
Editing Masterclass gives you the ultimate guide to 

turning your footage into a Hollywood blockbuster. 
Elsewhere, we’ve got tutorials to cover every user. It 

doesn’t matter whether you own a Mac, iPad, 
iPhone, Apple Watch or Apple TV, we’ve got the 

guides to help you get even more from your incredible 
device. Enjoy the issue. 

Philip Morris Editor
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The four-inch awakens
The expected launch of the newest 
iPhone in Apple’s roster heralds a 
return to one of Cupertino’s long-held 
design philosophies. Whether it’s the 

6c, 7c or 5e and released in March or April is still 
shrouded in a veil of secrecy, but the word on 
everyone’s lips is that the 4-inch screen is back. 

The iPhone 6 Plus increased the screen size of 
the iPhone by nearly 50 per cent, bringing Apple 
firmly into the era of the phablet, which was a 
huge departure from Steve Jobs’ 2010 assertion 
that ‘no one’s going to buy a big phone’. However, 
times have changed since that quote and seeing 
as so much media is consumed on our mobiles, 
Apple’s hand was pretty much forced.

However, in the iPad range is a raft of portable 
devices on which Apple users can watch TV and 

movies, so the bigger screen isn’t as essential as 
it is for Android users. Therefore, while they are 
forced to lug giant 6- and 6.5-inch giants around, 
Apple users can happily get all they need with 
their phone-sized phones. 

We were somewhat surprised when the budget 
model didn’t launch alongside its bigger brothers, 
but this could have been because Apple didn’t 
want it overshadowed, literally and figuratively, by 
the 6 and 6 Plus. Or, on the flip side, Apple could 
have been worried that the presence of a 4-inch 
model would be a more tempting proposition for 
users happy with what they’ve got. The extra six 
months has meant that everyone who wanted a 
big iPhone probably now has got one, leaving the 
way clear for the new model to make its own way 
in the world. 

There are currently two schools of thought 
regarding the new model’s spec sheet. One 
school seems to believe it’s basically going to be 
a mini version of the 6s with a very similar spec 
sheet – A9 processor, 2GB RAM and 16GB or 
64GB storage – but a smaller battery to help it 
be lighter and thinner. The other opinion is that 
it’s going to be an updated version of the 5s, the 
previous generation’s premium model with a few 
updated features, such as Apple Pay support and 
voLTE, which would make this model an entry 
level current generation model. The latter seems 
the most likely, as Apple’s strategy of releasing a 
standard model, a premium model and an entry 
model, such as the 5, the 5s and the 5c. With 
the iPhone 6 and 6s already out on the market, 
a mini premium model wouldn’t make a whole 
lot of sense unless Apple is trying to target those 
users who want the latest product but aren’t a fan 
of that enormous screen. It seems much more 
likely that Apple is going to push ahead with its 

#Trending

The imminent return of Apple’s four-inch screen raises plenty of questions…

“That is Apple all over. Make a bold decision, 
disrupt the market but keep core fans happy”
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Five iPhones that surprised us all Which five iPhone models surprised us the most? 

Will the new budget iPhone 
share a spec sheet with the 
iPhone 5C or the iPhone 6S?

iPhone 
Gen 1
Well, the most 
surprising 
iPhone of the 
lot has to be the 
very first one. 
It completely 
redefined the 
smartphone 
world with its 
huge, at the time, 
touchscreen, 
home button and 
gorgeous design.

iPhone 
Gen 1
Well, the most 
surprising 
iPhone of the 
lot has to be the 
very first one. 
It completely 
redefined the 
smartphone 
world with its 
huge, at the time, 
touchscreen, 
home button and 
gorgeous design.

iPhone 3G
As the name 
implies, this was 
the first iPhone 
to introduce 3G 
data connections 
and that paved 
the way for us 
to start 
browsing the 
web on our 
phones with 
a speed we 
couldn’t have 
imagined before.

iPhone 3G
As the name 
implies, this was 
the first iPhone 
to introduce 3G 
data connections 
and that paved 
the way for us 
to start 
browsing the 
web on our 
phones with 
a speed we 
couldn’t have 
imagined before.

iPhone 4s
“Hey Siri, what 
is the most 
revolutionary 
artificial 
intelligent 
assistant 
available on 
mobile devices?” 
The hands-free, 
voice-activated 
addition to the 
iPhone 4s was 
an enormous 
leap forward.

artificial 

assistant 
available on 

The hands-free, 
voice-activated 
addition to the 

an enormous 

iPhone 5
Not all surprises 
are great 
surprises. The 
iPhone 5 saw the 
30-pin charger 
replaced by 
the Lightning 
connector, which 
then became 
the standard for 
all mobile Apple 
products. Maybe 
the headphone 
port will be next?

are great 
surprises. The 

30-pin charger 

the Lightning 
connector, which 
then became 
the standard for 
all mobile Apple 

the headphone 

iPhone 6 
& 6 Plus
We all thought 
it would never 
be done but in 
September 
2014, that 
4-inch barrier 
was finally 
breached and 
Apple entered 
the plus-sized 
smartphone 
market. And boy did it 
smash it. 

standard and premium models as phablets and 
the entry model as a 4-incher as its base model, 
so the difference between the three models is 
clear. After all, how many people would pay a 
couple of hundred pounds more for a phone 
with exactly the same specs but a slightly larger 
screen? It makes much more sense for the third 
phone in the trilogy to be the bargain of the three 
and an upgrade on the previous generation’s 
model to stop those who went out and snapped 

up the iPhone 6s from feeling as though they have 
lost out in the updates. 

The move to screens larger than four inches 
was a big step for Apple and that has had a 
knock-on effect for its third model. Does Apple go 
all out for the big model or keep it purely for the 
premium phones? Cook, Ive et al have decided 
to drop down a size to keep their core fans, who 
loved the ability to navigate their phone with one 
hand. And that is Apple all over. Make a bold 

decision, disrupt the market but always keep the 
core fans happy. Bring out the mega model that 
everyone had been clamouring for and dominate 
the industry but find an alternative way to appease 
those that love Apple’s style. 

The iPhone 6c, 7c or 5e with an A8 or A9 chip 
isn’t even out yet, but what it is doing is showing 
that no matter what Apple does, no matter how 
the market changes, it always has its most loyal 
fans at its heart. Long may that continue. 

Which five iPhone models surprised us the most? 

iPhone 6 
& 6 Plus
We all thought 
it would never 
be done but in 

4-inch barrier 

breached and 
Apple entered 
the plus-sized 

market. And boy did it 

decision, disrupt the market but always keep the 
core fans happy. Bring out the mega model that 
everyone had been clamouring for and dominate 

The iPhone 6 was the first 
iPhone to break the four-inch 
size barrier

Could the new smaller iPhone 
come in a range of colourful 

cases like the iPhone 5c?

Maybe consumers thought 
Apple had stumbled on the 
perfect size with the iPhone 4s

7
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#Trending

Things we learned 
this month

The 3.5mm jack 
really looks like it’s 
on its way out

Reports from multiple sources are 
making it seem ever more likely 
that the industry standard 3.5mm 
headphone jack won’t be included 

on the iPhone 7. The cumbersome port looks 
like being the next thing to go in Apple’s 
commitment to creating the thinnest possible 
phone and, despite initial surprise and horror, 
looks like it could be a good decision. As well 
as the aesthetic advantage of not having a 

gaping great hole in your iPhone, the loss of 
this port could convince users to move more 
towards Bluetooth headphones that don’t 
have irritating wires that get easily tangled. 
However, for those of you who like to remain 
connected, headphones with a Lightning 
connector will also be available. Once again, 
Apple shocks the world with a bold move that, 
after the first round of standard objections, is 
already being accepted in the industry.
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Apple Watch outsold all 
other smartwatches in 2015 
Apple Watch

It’s something we had long suspected, but 
figures released have confirmed that the 
Apple Watch destroyed the competition in 
2015. The timepiece accounted for 52 per 

cent of all smartwatch sales in 2015, despite only being 
on sale for two-thirds of the year. Android Wear devices, 
by contrast, only made up 10 per cent of the overall 
total, showing that Apple’s style and functionality has 
won over the volatile smartwatch market.

You can switch to Night 
mode in iOS 9.3 iOS 9.3

iOS 9.2.1 hasn’t even been out that long but 
already we are able to get our hands on iOS 
9.3. The most exciting update to this version 
of the iPhone’s operating software is a Night 

Shift feature that reduces the amount of blue light in the 
iPhone’s display and increases the amount of yellow 
during the evening and night hours. This is due to the 
blue light of the display disrupting sleep patterns. The 
update also includes more 3D Touch actions and an 
extra layer of security for Notes.
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iCreateMagazine
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@iCreateMagazine

Web
icreatemagazine.com

Email
icreate@imagine-publishing.co.uk

“The timepiece accounted for 52 per cent of all 
smartwatch sales in 2015, despite only being 
on sale for two-thirds of the year”

“Apple shocks with a 
move that is already 

being accepted by 
the industry”

tvOS gets Bluetooth 
keyboard support tvOS

 The Apple TV has already given us 
many hours of delight, but also 
many minutes of frustration as we 
use the Apple TV Remote to 

arduously type passwords and the names of apps and 
shows we want to watch. Well, those days look set to 
be a distant memory because tvOS 9.2 is out, bringing 
with it support for Bluetooth keyboards to be hooked 
up so you can type whatever you need in the blink of 
an eye. tvOS 9.2 also lets you put your various 
downloads into folders, so you can group your games, 
movies and TV shows together. 

Apple Music is catching 
up with Spotify Apple Music

Apple Music has only been in existence for 
a little over six months but already it has 
burst through the 10 million subscribers 
barrier. The music streaming service has 

surpassed all expectations and now sits only behind 
Spotify in subscriber numbers, with experts predicting 
that it will gain the number one spot by 2017. Apple 
Music’s stats are remarkable, considering it has 
reached the milestone over ten times faster than 
Spotify, which now has over 20 million subscribers. Tim 
Cook is said to want to achieve 100 million subscribers, 
so you’ve made a good start, Tim!
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1 Activate AirDrop
Pull up from the bottom of the screen, 
then pull up again. This will reveal your 
Control Centre. Tap on AirDrop and then 
select Everyone. 

1 Enter Settings
Tap on the Settings icon on your 
iPhone’s home screen. Next, hit Mobile 
Data to enter the menu containing your 
pre-paid data options. 

1 Open your settings
Move your cursor over the Apple logo in 
the top left-hand corner of your Mac’s 
screen and click it. Next, hit the About 
This Mac menu.

2 Share files
Tap on the item you want to share and 
the familiar share icon (arrow coming out 
of a rectangle) will appear in the top-right 
corner. Tap on that.

2 Find Wi-Fi Assist
Scroll all the way to the bottom of the 
Mobile Data menu where you will find the 
menu marked Wi-Fi Assist. Tap on the 
grey slider to activate it. 

2 View system report
If you are running El Capitan you will see 
a menu pop up. Click System Report. 
Anything pre-El Capitan will need you to 
hit More Info before System Report.

3 Send to device
As long as the iDevice you want to send 
your files to also has AirDrop turned on, 
they will appear below the files. Tap the 
name to send them across.

3 Wi-Fi Assist options
Above this is your app list. Tap on the 
green slider to prevent it being part of 
Wi-Fi Assist. Video and music services 
cost a lot of data, for example.

3 Bluetooth version
Click on Bluetooth, which is in the menu 
on the left. If your LMP Version is 0x6 or 
above, you have Bluetooth 4.0. Version 
0x5 is Bluetooth 3.0. 

AirDrop is a brilliant 
method of 
transferring 

numerous files without 
bothering with the likes of 
Dropbox or sending dozens 
of emails. Use your iPad’s 
AirDrop to send files to your 
iPhone, Mac or another iPad.

When pairing 
certain Bluetooth 
devices to your 

Mac, the version of Bluetooth 
you have can be important. 
Some newer devices won’t 
pair with older versions, so 
here is how to check what 
version your Mac is running.

2  Send files 
via AirDrop

3  Check your 
Bluetooth version

Wi-Fi isn’t the most 
stable of things and 
your web browsing 

can be at the mercy of a 
good connection. Wi-Fi 
Assist will get 3G or 4G to 
immediately kick in if the 
Wi-Fi signal is lost, so you 
can continue uninterrupted.

1  Activate 
Wi-Fi Assist

Wi-Fi and Bluetooth are two parts of network connectivity that 
have very much taken a back seat in terms of importance since the 
emergence of 4G and unlimited data contracts. However, they still can 
play a vital role in the day-to-day use of your iPhone, iPad and Mac, 
helping you transfer documents and avoid running up huge bills. As 
such, we’ve put together a few things you can do with your iDevices to 
make the most of these two forgotten network stalwarts.

MINUTE PROJECTS
TO TRY TODAY

3
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The world’s best color corrector is now the world’s best editor!
Unlimited Audio E	ects
Now you can create the perfect mix by adding VST and Audio Unit 
plugins to entire tracks or individual clips! Resolve’s sample accurate 
playback and smooth tape style scrubbing let you precisely edit audio 
in the timeline, or you can record fader automation using the new mixer! 
You can even export directly to ProTools for finishing!

Hollywood’s Best Color
DaVinci is the world’s most trusted name in color and has been used to 
grade more Hollywood films, TV shows, and commercials than anything 
else. Now you can switch between professional editing and Resolve’s 
legendary color tools with a single click. DaVinci Resolve 12 goes far 
beyond anything you’ll find in any other editing systems!

Only DaVinci Resolve 12 combines professional editing with advanced 
color correction so you can edit and grade from start to finish, all in one 
single software tool! With over 80 incredible new features including 
multicam editing, advanced trimming, high performance audio, and 
incredible media management, DaVinci Resolve 12 is the editing solution 
you’ve been waiting for.

Super Fast Editing
DaVinci Resolve 12 has a massive set of professional editing and 
trimming tools that work exactly as you expect. You get context sensitive 
editing, dynamic and asymmetric trimming, titling, transitions, animation 
and more! The familiar multi track timeline, customizable interface and 
keyboard shortcuts make it easy to switch to DaVinci Resolve 12.

Incredible Multicam
No matter how many cameras you have on your shoot, DaVinci Resolve 
12 lets you edit programs shot on multiple cameras faster than ever 
before. Quickly sync angles using timecode, in/out points, or even 
automatically based on sound and then watch them all playback in 
realtime while you cut between angles on the fly!

View Demo

DAVINCI RESOLVE ��
Free Download now, for Mac OS X and Windows. 
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The fact that both of the sentences 
above this one are questions sums 
up pretty much everything you need 

to know about Project Titan. Thousands of 
column inches have been dedicated to trying 
to work out exactly what is going on behind 
the scenes at Cupertino and we’re still no 
nearer to knowing Titan’s end game. 

It’s pretty much guaranteed it’s going to be 
something car-based, judging by the sheer 
volume of people with motoring backgrounds 
Apple has been hiring. Many of these have 
come from Tesla, the electric car innovation 
pacesetters, and as it’s Apple, you know it’s 
going to be something pretty darn innovative. 

Rumours of the Apple Car being an 
autonomous, electric vehicle have been 
swirling around for nearly two years now, 
especially as Apple has registered a few 
interesting domain names, such as apple.car, 
apple.cars and apple.auto. 

However, this could all be explained away 
by two words: Apple CarPlay. The most likely 
goal behind Project Titan is the advancement 

of Apple’s in-car infotainment software, and 
all these appointments have been made to 
understand more about the industry. 

Apple is unlikely to take on the major 
players in the automotive world just yet, at 
least not until there is a proven market for – 
and profitability in – electric and autonomous 
cars. Tesla’s huge financial losses show that 
the former isn’t there yet and the lack of 
worldwide legislation on autonomous cars 
puts the brakes on the latter.

The current estimate for the arrival of 
driverless cars is around 2020 with the likes 
of Nissan, Toyota, Tesla and Google at the 
forefront of the charge. Apple may start to 
look into challenging them at some stage but 
right now we can’t see it happening.

Is the Apple Car 
actually going to 
be a thing?
What is Project Titan and when will we see the results?

#Trending

Apple has been poaching Tesla employees but 
is it for their technical or industry knowledge? 

Tesla has its own 
centre console in 
operation already 

If the Google Car is the best thing 
autonomous driving has to offer, 
Apple doesn’t have much to fear

To find out more about concept cars, 
check out Gadget magazine, 
the ultimate guide to the 
coolest new tech. Buy it 
here: bit.ly/1PhwB0M Apple has been poaching Tesla employees but 

To find out more about concept cars, 
Gadget magazine, 

the ultimate guide to the 
coolest new tech. Buy it 
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CRITICAL iCLOUD 
TRICKS & FIXES

50
iCloud is the one Apple feature that is guaranteed to split opinion. Some users 
won’t go near it, refusing to put their digital life in the hands of an unknown 
‘cloud’, while others simply couldn’t live without it. At iCreate, we’re firmly in 
the latter category. We love the way iCloud connects our device in amazing 
ways. iCloud Photo Library and iCloud Drive keep all your photos, videos and 
documents stored safely and constantly updated across all your devices. 
Family Sharing lets you share all your iTunes and App Store purchases with 
other family members, and Find My iPhone helps you out when you can’t find 
your devices. Your digital life is synced so perfectly it means you always have 
access to the files that matter most. 

But are we really making the most of iCloud? That’s what we’ve set out to 
address in this feature. The opportunities are virtually endless with iCloud, 
but when we ran a Twitter poll to over 6,500 of our followers, 80% said they 
weren’t making the most of iCloud. We also ran a readers’ survey, asking 
readers what they thought about iCloud. The results have structured the 
following feature for us. You told us what you want more of, and we’ve given 
you the answers. You’ll find a raft of expert tricks to help you master Apple’s 
cloud-storage feature and critical fixes for the times when things go a bit 
wrong. If you don’t have iCloud, check out the quick set-up guide across the 
page, and let’s get started. 

Everything you need to know to 
become an iCloud expert 

14



8 If you’re reading this and you 
haven’t set up iCloud yet, don’t 

worry – you’re not alone. Plenty of Apple 
users have resisted ‘the cloud’ for many 
reasons. We firmly believe that the positives 
far outweigh the negatives. Thankfully, 
Apple makes setting up an iCloud account 
simple. All you need is an Apple ID and the 
following instructions…

1 Set up on Mac
Go to System Preferences and select iCloud. Activating 
iCloud is now as simple as entering your Apple ID and 
enabling which features you want synced. 

2 Set up on iOS
On your iOS device, head to your Settings menu and 
tap iCloud. Type in your Apple ID credentials, tap Sign 
In and choose what you want to sync to iCloud. 

Haven’t set up iCloud yet? 
Here’s how to get started

6 Find iPhone
Lost your device 

or had it stolen? iCloud’s 
brilliant Find My iPhone/
Mac service will locate it 
for you and give you extra 
security options if the worst 
happens. You’d be silly not 
to have it set up. 

4 Notes
The Notes app 

on Mac and iOS received 
a major upgrade in OS X 
El Capitan and iOS 9. If 
you’ve found yourself using 
it more and more, you’ll 
be pleased to know that 
iCloud syncs your notes 
between all devices.

5 iCloud Drive 
Did you know 

iCloud has its own 
file storage directory 
called iCloud Drive? It’s 
essentially the same as 
Dropbox, enabling you to 
add any type of file and 
have access to them on 
any device.

3 iWork 
documents

Getting productive on 
your Mac or iOS device 
is easy with iWork. Did 
you know you can access 
fully featured versions of 
the Pages, Numbers and 
Keynote apps in a web 
browser on any device? 

2 Photo library
If you have iCloud 

Photo Library enabled, all 
your photos are backed up 
to iCloud. You can access 
a copy of your library from 
icloud.com and download 
photos to any device.

How to set 
up iCloud

80% of users aren’t making the most of iCloud
Are you one of the many that doesn’t fully appreciate what iCloud can do?

15

You can access everything you sync with iCloud from a web browser at 
www.icloud.com. Sign in with your Apple ID to load up the screen below.1

Compatible web 
browsers

To use iWork for iCloud 
you need to be running the 

latest versions of Safari (6.0.3 
or later), Chrome (27.0.1 or 

later), or IE 10.0.9.

7



Rescue storage space 
by getting rid of 
unwanted backups

1 Manage storage
You can do this on any device you have 
iCloud. We’re doing it on a Mac. Go to 
System Preferences>iCloud and then head 
to the Manage tab in the bottom-right. 

2 View backups
Select Backups from the left sidebar to be 
presented with all the backups associated 
with your iCloud account. Take a look at 
the date and size information.

3 Delete backup
Select an individual backup and click 
Delete. A warning message will appear 
asking you to confirm. Choose Delete again 
to have the backup permanently removed 
from your account. 

Re-download all of your old 
iTunes purchases
Use the cloud to get access to 
historical purchases
11 iCloud links with your iTunes and App Store 

accounts so you have access to every 
track, album, movie or app you’ve ever bought with 
your Apple ID. Go to the Purchased tab in iTunes, for 
example, and tap on the cloud icon to download 
content to your device. It’s great for anyone with a 
new iPhone or iPad, wondering if they’ve lost their 
purchases. Feel free to delete items if you wish, safe 
in the knowledge it will always be in the cloud. 

Downgrade your 
iCloud account
Change your storage plan and save 
some money
12 If 5GB still isn’t enough cloud storage, 

upgrading your account is painless. Apple 
changed its iCloud storage plans last year, meaning 
for just £0.79/$0.99 you get a total of 50GB storage. 
But did you know you can downgrade your plan, 
too? If you’re saving loads of space following these 
tips, go into your iCloud settings and tap Change 
Storage Plan under Manage Storage. Then go to 
Downgrade Options and choose what’s appropriate.

9 Did you know iCloud stores 
historical backups? Here’s 

how you can delete them.

1 iCloud storage
On your iOS device, go to 
Settings>iCloud>Storage 
and then select the Manage 
Storage option. All your 
backups are listed. Choose the 
biggest by tapping it.

2 App space
Scroll down and choose to 
view all the app data that is 
being backed up. Those with 
128GB devices and hundreds 
of apps will be amazed by how 
much space they take up.

3 Delete app data
Have a look at what you can 
get rid of from your backups. 
It’s probably loads. Hit the 
green switch to turn off future 
backups of the app and delete 
iCloud data.

Halve the size of your iCloud backups
Get selective with the app data you back up

Essential iCloud back-up and security tricks
Restore from old backup

22 Got a new shiny Apple 
device? You can set it up 

with an existing iCloud backup that 
contains all your apps and data, 
and much more. Instead of setting it 
up as a new device, select the 
iCloud option, select the most 
appropriate backup (probably your 
most recent) and off you go.

Reset security questions

23 If you don’t have two-factor 
authentication set up, the only 

way to reset your Apple ID details is to 
answer security questions you set up. 
It’s a good idea to review these to make 
sure that you actually know the 
answers. Go to http://appleid.apple.
com, click Manage your Apple ID and 
click Password and Security. 

Set up two-factor authentication 

24 Two-factor authentication is 
Apple’s attempt at protecting your 

Apple ID and iCloud account in OS X El 
Capitan or iOS 9. It works by creating a 
‘trusted’ device which is used as a 
confirmation source (you’ll need to enter a 
six-digit passcode) when an unknown 
device tries to log in to an Apple service 
using your ID. 

Set up two-factor authentication 

Apple’s attempt at protecting your 

confirmation source (you’ll need to enter a 

10
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Track your device on 
any machine
You can use Find My 
iPhone from a Windows 
machine if you must
21 If you’ve only got one Apple 

device and that is lost or stolen, 
there is still a way to access all of 
iCloud’s functionality. It doesn’t matter 
what device or browser you use – an 
Android tablet or a Window desktop 
would be fine – because by logging into 
www.icloud.com and entering your Apple 
ID and password, you get access to 
everything iCloud has to offer. In this 
case, you’ll want to visit Find iPhone from 
the main screen.

Send your device’s last location
See your device’s last location before its 
battery dies

20 Find My iPhone only works 
if your lost or stolen device 

is awake. When the battery runs 
out, Find My iPhone won’t be able 
to pick up your device’s signal. To 
ensure you still have every chance 
of tracking it down, ensure you have 
the Send Last Location option 
activated. On your iOS device, go to 
Settings>iCloud>Find My iPhone/
iPad and enable Send Last Location 
to automatically send the location of 
that device to Apple when the 
battery is critically low.

Five things to do if your device is lost or stolen
Use iCloud’s essential Find My iPhone feature to stay secure

Back up before 
updating

25 If you have iCloud set 
to back up whenever 

you’re connected to power 
and Wi-Fi, you don’t need to 
worry about it. It’s all done in 
the background. The only time 
we’d recommend backing up 
manually (tap Back Up Now) is 
just before you update the 
operating system. Safety first. 

Use iTunes to perform 
manual backups

26 You don’t need to be 
signed into iCloud to 

back up your favourite devices. 
Apple enables users to back up 
manually through the old-
fashioned, plug-it-into-iTunes 
way. It’s less convenient but it 
is a way of keeping everything 
in check if you run into Wi-Fi 
and data issues. 

Reset Keychain 
security code

27 Forgotten your iCloud 
Keychain passcode? Go 

to Settings>iCloud and select 
Keychain. Enter your iCloud 
password, tap Advanced>Change 
Security Code and then type in a 
new code. You can also tap on 
Advanced Options to choose a 
more complex option or have one 
generated for you. 

17 Erase device
This is the last option but one 

that keeps all your personal information 
secure from prying eyes. Click Erase iPad 
and accept the warning by hitting Erase.

14 Multiple devices
Use the drop-down menu at the 

top to switch between devices attached 
to your iCloud account. It doesn’t matter if 
it’s a Mac, iPad or iPhone.

15 Play Sound
If you’ve misplaced your device 

but you know it’s nearby, click Play Sound 
to hear a loud alarm bell play instantly. 
Swipe to unlock it to stop the noise. 

16 Exact location
Head to iCloud.com and select 

Find iPhone. Any devices attached to your 
iCloud account will show on the map. A 
green dot shows you their location. 

18 Lost mode
If you select Lost Mode you can 

lock your device by entering a six-digit 
passcode. Then enter a phone number – 
this will be displayed on your lost device.

17

You can enable Find My iPhone/iPad/Mac in your iCloud Settings menu. 
Make sure there is a tick next to the option.13

Stay safe with 
Activation Lock

Activation Lock is automatically 
turned on. Your Apple ID and 
password is then required to 
turn off Find My iPhone, sign 

out of iCloud and erase 
and reactivate your 

device.
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Create a 
shared calendar
Ensure you always know what’s going on 
with family and colleagues 

28 Sharing a calendar has many benefits. It’s a great way for work 
colleagues to see when meetings and presentations are 

happening, and a great way for couples to keep up to date with their 
social calendar and big events. No one likes to double-book themselves, 
after all. Apple makes sharing iCloud calendars as easy as you’d expect 
– all it takes is a couple of steps. And because the information is stored 
in your iCloud, you can view changes on any of your devices.

1 iCloud calendar
Load up your Calendar app. We’re using an 
iPad here. Head to the bottom of the screen 
and tap Calendars to see a list of all the 
calendars you have synced to your device.

2 Share with
Choose one of your iCloud calendars and 
tap the ‘i’ button next to it. This lets you edit 
your calendar. Tap Add Person, and type their 
name in to send an invitation. 

3 Allow editing?
Once they have accepted the invitation, your 
calendar is shared. You can now tweak some 
key settings, such as whether to allow them to 
make changes to the calendar.

1 Load up Contacts
Open your Contacts app on 
your Mac by clicking its icon 
in the Dock or heading to 
your Applications folder and 
searching for it.

2 Export menu
Now go up to File in the 
menubar and scroll down to the 
Export menu. From the options 
that slide out right, select 
Contacts Archive to continue.

3 Safe place
All that’s left to do is save your 
Contacts archive to a safe 
destination. Hit Save when 
ready. Your contacts information 
is now safely backed up.

Archive your 
contacts

Share huge 
files over 
email
Use iCloud’s Mail Drop 
for files up to 5GB

29 Fed up of using 
WeTransfer or 

Dropbox to transfer large file 
sizes over email? We were 
too, until we started using 
iCloud’s brilliant Mail Drop 
feature. As long as you have 
the ‘Send large attachments 
with Mail Drop’ setting ticked 
in the Advanced section of 
Mail>Preferences>Accounts, 
you can send files up to 5GB 
in size over email. The 
recipient will be sent a link to 
access the contents, which 
stays active for 30 days.

Ensure you always 
have an up to date 

backup of your contacts 
in case iCloud goes wrong

30
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Store and auto-fill 
passwords in Safari
iCloud Keychain makes web 
browsing safer and a lot easier 

31 How many times do you 
tediously enter usernames 

and passwords to log in to the same 
websites and services every single 
day? A lot, no doubt. Apple’s answer 
to your web browsing woes is iCloud 
Keychain, a part of iCloud that stores 
usernames and passwords for you, 
as well as payment information and 
Wi-Fi network names and passwords. 
Once it’s set up, Safari will offer an 
Auto-Fill option when it comes to 
logging in to one of your most-used 
websites. Here’s how to set it up. 

4 iCloud Security Code
With Keychain now activated, go back and 
click the Options tab. This will let you enter 
a phone number to be used for verification 
purposes. Better be safe than sorry.

1 iCloud account
You need to activate iCloud Keychain on every 
device. Setting it up is the same on any device 
and requires a visit to your iCloud menu in 
System Preferences or Settings.

5 Password suggestion
iCloud Keychain will help you come up with 
much safer passwords, too. When you’re 
completing a sign-in sheet, Safari will now 
offer super-secure suggested passwords.

2 Apple ID password
Scroll down until you see the Keychain option. 
Enable it by ticking the box next to it. You’re 
then asked to enter the Apple ID password 
you use with iCloud.

6 Auto-fill passwords
And because iCloud Keychain stores your 
usernames and passwords, logging in to your 
favourite sites has never been easier. Safari 
does the hard work and auto-fills it for you.

3 Approval request
If you have other devices running iCloud you 
can send an approval request to that device – 
enter your Apple ID info again when it pops up 
– or enter your iCloud Security Code.

Apple uses 256-bit AES encryption to secure your iCloud Keychain, but you 
can also set up two-factor authentication to verify your identity.32

Save credit 
card information

iCloud Keychain also stores 
your credit card number and 

expiry date for when you need 
to auto-fill that information. 
No need to reach for your 

wallet ever again!

33
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Set age 
restrictions to 
shared iCloud 
content

1 iTunes Preferences
Open iTunes and head up to the app’s 
main menu. Select Preferences from the 
drop-down menu and then click on the 
yellow Restrictions tab.

2 Admin privileges
To make any changes you’ll need to 
type in your Mac’s admin username and 
password. Click the padlock in the bottom-
left corner and then OK when done.

3 Restrict content
Under the Restrict sub-heading, tick the 
boxes next to the restrictions you want 
to enforce. Confirm by selecting Restrict 
Explicit Content or similar and then OK.

Make sure young eyes don’t 
get access to sensitive media 

35 Access in 
Finder

You can find an iCloud Drive 
app in iOS 9, but on your Mac 
iCloud Drive lives as part of 
any Finder window. It appears 
under Favorites by default.

38 Create new 
folders

Keeping organised in iCloud 
Drive is straightforward. 
Creating new folders is a 
simple way to start. Select 
Cmd+Shift+N or right-click and 
select New Folder.

36 Navigate 
folders

You navigate around iCloud 
Drive just like any other folder 
on your Mac. Simply double-
click on a blue folder to get 
quick access to its contents. 

39 Opening 
specific files

As you’d expect, clicking on 
a file inside an app folder, like 
Pages, Numbers or Keynote, 
will load up the relevant 
app. It’s this integration that 
Dropbox doesn’t have.

37 Delete files
iCloud Drive doesn’t 

have a specific delete option, 
so you need to drag files and 
folders to your Mac’s Trash 
can to get rid of anything that 
you don’t want. 

40 Choose which 
apps sync

You’re in complete control 
as to which apps are able to 
store documents and data in 
iCloud Drive. Go to System 
Preferences>iCloud>iCloud 
Drive and select Options.

Master iCloud Drive
78% of users have more than one cloud storage service, 
despite iCloud Drive providing everything you need…

iCloud Drive is Apple’s equivalent of Dropbox or Google Drive, and it currently isn’t being 
used as much as Apple envisaged. Nearly 70% of those who completed our survey use 
iCloud Drive, but 78% still use a rival cloud storage service. We think you’d be better off 

using just one – and we think iCloud Drive is the most underused part of the iCloud ecosystem. In 
iCloud Drive you can store, organise and share virtually any type of file and access them on your 
iPhone, iPad, iPod, Mac or even PC, as we show you here.

34 Family Sharing is a brilliant 
way to share all your App 

Store, iTunes and Apple Music content 
with younger members of your family. 
In some cases you might want to limit 
access to certain features and 
services, including explicit content. 
Here’s how to set restrictions in iTunes. 

50 Critical iCloud tricks & fixes
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Keep all your 
photos away 
from iCloud
Want to avoid any Jennifer 
Lawrence mishaps?

Three things you didn’t know iWork for iCloud could do

Utilise iCloud Photo Library to its full potential

Apple’s online productivity suite is packed full of secret features that anyone can access

iCloud Photo Library has unfairly got a lot of bad press. It 
only takes one person to take aim at it on social media to 
cause a storm, but when we asked readers if they’d ever 

had a problem with it, 8 out of 10 said no. Here are some useful 
tricks and fixes to take your use of iCloud Photo Library to new 
levels of expertise. 

Print direct from the web
48 If you’re using Pages for iCloud, you 

can print directly from your web 
browser. Click the Share icon>Print. A PDF of 
the doc is then created for you to print. 

Share docs as read only
49 Numbers enables you to share 

documents with anyone via an email 
link. The web app also lets you limit 
collaboration to View Only.

Play your keynote
50 You don’t need a Mac to present a 

Keynote. Load up Keynote for iCloud 
from any browser, press Play and the 
keynote plays in full-screen mode.

42 Pause iCloud uploads
When you first turn on iCloud Photo 

Library, there’s a lot of data being processed. 
If everything grinds to a halt, try the Pause for 
One Day option in Photos>Preferences>iCloud. 

44 iCloud Photo Sharing
iCloud Photo Sharing is a brilliant 

way to share images. Set a new album up from 
the Share menu, send invites and watch them 
like and comment on pictures.

43 Set up discreet libraries
As only the System Photo Library is 

synced to iCloud Photo Library, you can create 
other discreet libraries that you can access by 
clicking the Option key when you open Photos. 

45 Restore deleted images
Any image you delete from your 

iCloud Photo Library is stored for 30 days in a 
Recently Deleted folder on OS X and iOS. You 
can recover wrongly deleted images here.

47 iCloud is very safe and 
secure, but mishaps can 

happen. A host of celebrities have 
had their iCloud hacked and some 
rather embarrassing photos released. 
If you’d rather not have any of your 
photos backed up to the cloud, there 
are ways to safeguard. The first and 
most obvious thing is to turn off 
iCloud Photo Library – just make sure 
you back up manually via iTunes. 
iCloud also backs up your Messages 
though, so make sure you delete 
message threads with images 
attached to them.

Get more from iCloud Photo Library

iCloud Photo Library only backs up one library – your System Photo Library. 
By default this is the one found in your Mac’s Pictures folder.41

Utilise iCloud Photo Library to its full potential

Use iCloud 
Photo Sharing on 

non-Apple devices
You don’t need an Apple ID, 
or even an Apple device, to 
use iCloud Photo Sharing. 
Invitations are sent via a 

web link that gives 
you access.
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Thanks to phenomenal advances in technology, you can 
now record High Definition video footage on gadgets such 
as DSLRs, GoPro cameras and even on your iPhone. You 
also have access to the type of post-production video-
editing tools that film-makers in previous decades would 

have had to have spent hundreds of pounds to access. Today the only 
limitations on sharing high-quality video productions are our own 
imagination and a bit of technical experience. 

This iMovie masterclass is designed to help you become more familiar 
with the video production workflow, so that you can confidently capture 
high-quality footage, import it into your Mac and then sort out the wheat 
from the chaff to create a short, slick and watchable programme. As well 
as overcoming production (shooting) problems such as camera shake 

and incorrect colours, we’ll show you how to enhance your 
shows with post-production assets like captions, transitions, 
and sprinkle in a dash of special effects courtesy of green 
screen compositing and picture-in-picture effects. You’ll also be 
able to add digital camera moves to clips and stills to enhance 
your programmes, thanks to iMovie’s Ken Burns tools. These 
post-production assets act as ‘icing on the cake’ and give your 
programme the type of professional production values that people 
have come to expect.

It’s now also much easier to share your footage thanks to social 
media platforms such as YouTube levelling the distribution playing 
field. Anyone can now find and build an international audience from the 
comfort of their own Mac thanks to iMovie.

Become an expert in recording, editing and sharing video

iMOVIE 
EDITING

MASTERCLASS 
iMOVIE 
EDITING

MASTERCLASS MASTERCLASS 

iMovie keeps all imported clips in a 
Library. To work with clips more easily 
you need to set up an event to store 
them in, and a project to edit them in. 
Here’s how to get clips into iMovie from 
an attached video camera or a folder 
located on your Mac.

Import footage 
into iMovie

1 Create a new event
Choose File>New Event. By default 
the event will be labelled with the 
current date, but you can re-label it 
to help identify its contents. Click the 
big Import Media button.

2 Import footage
From the Import window you can 
browse to an attached camcorder, 
external drive or Mac folder. Shift-
click to select clips to import. Click 
the Import Selected button.

3 Create the movie
The clips will appear in the event that 
you created. Go to File>New Movie. 
Choose a Theme from the options. 
Click Create. Label the movie and 
choose the event you created.

How to get your clips safely 
into an iMovie project
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Non-
linear editing

Once you’ve created an 
event, imported your clips and 

created a movie template, you’ll 
see an empty timeline appear. 
You can then add your clips to 

the timeline in any order to 
start telling a story.

When shooting footage use a tripod. This will help you produce shake-free 
shots and also enable you to think about better composition.



Create a trailer

1 Choose a template
Click the New button and click the Trailer 
icon. Click the Play icon on a trailer’s 
thumbnail to preview its music, pacing and 
titles. Click Create when you find one you 
fancy. Add it to an event.

2 Use the Storyboard
Click on the Storyboard tab. This gives 
you editable text fields and placeholder 
graphics that suggest the type of shot you 
might add. Music and transitions are all 
added automatically.

3 Drag and drop
Modify the text fields to customise the 
trailer’s text and click on your event’s 
clips to drop them one by one into an 
appropriate placeholder. To see how 
things are shaping up, tap the spacebar to 
preview how the trailer looks and sounds.

Enhance your movies
Add titles, transitions, 3D Globes and travel maps

Once you have imported your footage into an event and created a timeline to add the clips 
to (see previous spread), then you can turn your rambling raw footage into a shorter, 
snappier story. You can trim clips’ durations to make them tighter and, just like editing an 

essay, you can swap clips around to fine-tune how your story unfolds. Once you have told your tale 
you can enhance it using iMovie’s post-production assets such as titles, transitions and even 
animated travel maps. The latter are a great way of setting the scene for your latest travelogue.

1 Create some titles
Click the Titles browser (or press Cmd+2). 
Scrub over a title thumbnail to preview it. Drag 
the title into the timeline. Edit the font, text and 
colour in the main viewer. Click the tick.

3 Use marvellous maps
Press Cmd+3 to summon Maps & 
Backgrounds. Drag a map into the timeline. 
In the main viewer, type in a journey start and 
end point for an animated arrow on the globe.

2 Add terrific transitions
Press Cmd+1 to summon the Transitions 
editor. This lets you mix or wipe between clips. 
Drag a transition between two clips. Double-
click the transition’s icon to edit its duration.

4 Add a background
Below the maps are a collection of still and 
animated backgrounds. These are great 
for creating attractive and slick-looking 
backgrounds for your project.

A trailer is a great way of 
presenting footage and 
getting people excited about it

“You can turn 
your rambling raw 

footage into a 
snappier story”

iMovie editing masterclass
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Less 
is more

iMovie’s transitions are fun 
to add, but you can get carried 

away. Think of transitions as 
adding salt to a meal. A little 
will enhance it but too much 

can spoil it. A pro will use 
less transitions than a 

novice.



 Increase contrast
By dragging this Shadow Control slider to 
the left, you create darker shadows. The 
Highlight slider will move an equal distance 
to the right to brighten the clip’s highlights.

 Colour correction controls
To access iMovie’s tools for correcting colour 
and tone, add a clip to the timeline and then 
click here. The Contrast, Saturation and 
Color Temperature sliders will appear.

Correct colour in your clips
Adjust colour and contrast to create shots with detail and impact

When filming with a handheld camera, 
your footage might look a bit wobbly. 
iMovie can analyse the camera shake 
and reduce or even remove it (though it 
will crop your footage after stabilising 
it). The best way to avoid shake (or a 
cropped clip) is to use a tripod.

Stabilise shaky 
footage

1 Add a clip
Add a shaky handheld clip to the 
timeline. Our example clip was filmed 
in a pool, making it impossible to use 
a tripod. Click on the Stabilization 
icon above the viewer window.

2 Smooth it out
Tick the Stabilize Shaky Video box. 
A little wheel will spin while iMovie 
analyses each frame. When the 
wheel stops, you should have a less 
shaky clip.

3 Shake versus crop
Toggle the Stabilize Shaky Video box 
on and off to see how much of the 
frame has been cropped. Drag the 
slider right for a smoother sequence. 
This will produce a tighter crop.

Iron out handheld wobbles 
for a smoother shot

 Balance colour
This icon gives you access 
to extra colour balance 
controls such as a White 
Balance eyedropper. This 
can banish colour casts 
by warming up or cooling 
down a shot in a click.

 Ungraded footage
Set your camera to 
neutral for footage with 
flat contrast and subtle 
colours. This helps avoid 
blowing out highlight and 
shadow detail and creating 
over-saturated colours.

 Tweak the 
temperature
If your shot looks a little too 
warm, then drag this slider 
left to cool it down and 
create more natural-looking 
skin tones. Drag it right to 
warm up a cold blue clip.

 Boost saturation
If your source clip’s colours 
are a bit drab then drag this 
slider right to increase the 
shot’s overall saturation. Be 
careful not to push it too 
far or you’ll create garish 
unrealistic colours.
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By shooting at a higher resolution (such as 4K), you can crop a clip to stabilise 
it and be in less danger of losing important details.



1 Split the clip
Scrub forward in the timeline 
until you get to the moment 
when you want time to switch to 
slow motion. Press Command+B 
to split the clip (or right-click on 
the clip and choose Split Clip).

2 Adjust the speed
Click to select the section of 
clip that you want to re-time. 
Click on the Speed icon above 
the viewer. Set the Speed drop-
down menu to the desired speed 
(such as Slow). Choose a %.

3 Fine-tune the speed
After slowing a section down, a 
tortoise icon will appear in the 
timeline. You can click on the 
top right of the re-timed clip and 
drag left to speed it up or right 
to slow it down even more.

4 Fast forward
You can also change a selected 
clip’s speed by going to the 
Modify menu. Here you can slow 
things down, speed them up 
and even create a slow Instant 
Replay of a sporting event.

iMovie makes it easy to 
speed footage up to 
produce dazzling time-

lapse sequences that show the 
ebb and flow of people and traffic 
in a busy city, or slow time down 
to watch a tree fall to earth. You 
can even split a clip so that it 
starts off in real time and then 
seamlessly slows down during a 
crucial moment. This variable 
speed effect is a great technique 
for enhancing action or sporting 
subjects, as we’ll demonstrate.

Speed up 
or slow 
down clips
Retime your footage to 
produce creative results

iMovie’s Ken Burns tools enable you 
to add movement to statically framed 
clips. These moves would be tricky to 
do in-camera, but in iMovie you can 
define a start and end size and let the 
Ken Burns tools zoom and pan between 
the keyframes smoothly.

The Ken 
Burns effect

1 Click to crop
Add a statically framed clip. This 
example footage was shot on a 
locked off tripod so only the people 
move. Click on the Crop icon above 
the viewer, then click Ken Burns.

2 Choose end point
Two boxes show the Start and End of 
the move. Click the End box to make 
it solid. Drag the corner handles to 
create a tight crop. Drag inside the 
box to pan or tilt.

3 Make a move
You can click the arrow icon to swap 
the size and position of the Start and 
End boxes. Click the Tick to apply. In 
this example the camera will zoom in 
and tilt up as the clip plays.

Enhance your clips with 
digital camera moves

26

iMovie editing masterclass

Keying 
and Ken Burns

Use Ken Burns to crop 
or recompose a composited 
green screen layer. Make the 
start and end boxes identical, 

and the recomposed clip 
won’t move. This fine-tunes 

the position of your 
subject.



Create a 
clever green 
screen effect
Combine separate 
clips into a creative 
composite sequence

By shooting a subject 
against a clean green (or 
blue) card, you can use 

iMovie’s keying tools to replace the 
colour backdrop. Green screens tend 
to be popular as many people have 
blue eyes (and these could become 
transparent when replacing a blue 
screen with other footage). This 
compositing technique is a great way 
of adding variety and texture to your 
productions. You can place people in 
exotic locations or add special effects 
to your drama productions.

1 Source footage
To get the green (or blue) 
screen footage to work well 
the card needs to be evenly lit 
(or holes can appear). Try and 
avoid shadows being cast 
on the card as these might 
remain solid.

4 Reduce fringing
The edges of the top layer’s 
subject may suffer a fringe 
of colour from the blue or 
green screen. Combat this 
by dragging Softness right to 
soften the edges and reduce 
the strength of any fringing.

2 Layer the clips
Drag the background footage 
to the timeline first. Then drag 
the blue screen clip onto the 
timeline and place it on a layer 
above the background clip. 
The two parallel clips need to 
run together.

5 Clean up corners
If bits of blue background still 
appear at the frame’s edges, 
click the Clean-up Borders 
icon. This enables you to drag 
the corner handles inwards. 
Areas outside of these handles 
will be completely transparent. 

3 Overlay options
Click on the top clip. Click on 
the Video Overlay settings 
icon above the viewer. Set the 
drop-down menu on the left 
to Green/Blue Screen. The 
blue card will instantly become 
transparent and disappear.

6 Erase shadow
Click the eraser Clean-up 
icon. In our example there’s a 
hint of flower shadow on the 
blue card at the bottom-right 
corner. By clicking the eraser 
on this area we can make the 
shadow vanish.

Picture-in-Picture

1 Layer two clips
Add a background clip to the timeline and 
then drag an insert image onto the top 
layer so both clips run parallel. Click the 
Video Overlay settings icon. Set the drop-
down menu to Picture-in-Picture. 

2 Refine composition
Drag the insert picture’s corner handles 
to resize it. Drag inside the picture to 
re-position. Yellow guides will help you 
align it with the centre. You can add a 
border and drop shadow, too.

3 Side-by-side
You can also change the Video Overlay 
settings to Side-by-Side. This causes the 
clip on the top layer to slide in from the left 
or right until it shares half the frame with 
the clip on the lower layer.

Present two clips at the same 
time to tell a story creatively
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By default, the Picture-in-Picture eff ect dissolves (or fades) in and then out. 
You can change this to a Zoom using the drop-down menu.



 Adjust levels
A subject’s voice should have levels that 
occasionally peak yellow at the loudest 
sections. Drag this horizontal volume bar up 
until the voice clip’s sound is strong.

 Audio effects
Click here to access extra audio effects that 
change the sound in more creative ways, 
such as altering pitch or adding different 
room ambience effects.

 Pump up the bass
When you reduce background noise, the 
subject’s voice can sound too flat and weak. 
Bring back some of the lower frequencies by 
choosing the Bass Boost preset.

 Sound fixing tools
Click on this icon to access iMovie’s tools 
for fixing sound. This will summon a handy 
Noise Reduction slider as well as the 
Equalizer drop-down menu.

Fix sound issues
Get your audio sounding its best with these post-production tools

Once you’ve fixed your clips’ recorded 
audio problems, augment your 
programmes with extra assets. iMovie’s 
Sound Effects browser is full of audio 
assets, from a collection of Foley sound 
effects to a folder of Jingles that suit a 
range of programme themes and topics.

Add a 
soundtrack

1 Add sound effects
In the Content Library panel, click 
the Sound Effects browser. Plunder 
the Sound Effects and iLife Sound 
Effects folders for a range of sounds 
to drag to the timeline.

2 Incorporate a voiceover
Click the Microphone icon to record 
a voiceover. Use the slider to adjust 
sound levels before you record so 
that they peak healthily. Click the 
Red button and speak.

3 Bring in music
Go to the iLife Sound Effects 
Jingles folder and drag a track to 
the timeline. To stop the music 
competing with dialogue, drag the 
horizontal volume bar downwards.

Use sound effects, 
music and voiceovers

 Reduce 
background noise
If background noise is 
competing with your 
interviewee’s voice, tick 
this box. Drag the adjacent 
slider to the right to get a 
balance between reducing 
the background noise 
without flattening the voice 
too much.
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iMovie editing masterclass

Go 
external

For a professional 
voiceover, buy an external USB 

microphone such as the Yeti 
(www.bluemic.com/yeti/#). This 

will create a more intimate-
sounding voiceover than 

your Mac’s mic.



1 Choose YouTube
Double-click to open up the project that 
you want to share so that it appears on the 
timeline. At the top right of the viewer, click on 
the Share icon. Click on the YouTube icon.

3 Public or private?
Choose a category for your programme and 
select your desired privacy setting (to make 
your video public or private). When you’re 
happy, click Next and then click Publish.

2 Select a size
In the next window, type in some keyword 
tags so viewers can find your content. Choose 
an HD size such as HD720p (or the larger 
HD1080p if you shot in that resolution).

4 Publish
A circular progress wheel will appear at the 
top right, indicating the progress of your 
upload. Then check out your programme on 
your YouTube channel and wait for comments.

Share directly to YouTube
Distribute your programme to the 
world directly from iMovie

Once you’ve spent time getting your programme 
to look and sound as good as it can, it is 
possible to quickly and easily share your edited 

masterpiece with a global audience thanks to iMovie’s 
direct link with social media platforms such as YouTube. 
YouTube enables you to create a personal channel that 
fans of your work can subscribe to, so there’s potentially 
plenty of people to be impressed with your iMovie 
editing skills. Here is a range of social media 
sharing workflows to get stuck into…

Share to 
Facebook/Vimeo

1 Click on Share
Facebook is a great place to get instant 
feedback on your video productions from 
an audience that knows you (especially if 
you choose to share it just with friends). 
Click the Share icon and choose Facebook.

2 Choose an audience
You’ll need to tell iMovie your Facebook 
login details. In the Facebook pop-up 
window choose a Size – HD720p will be 
fine. Choose who can view your uploaded 
movie and then click Next.

3 Publish it
In the next window, click Publish. iMovie 
will notify you when it has uploaded your 
edited programme to Facebook. Click Visit 
to see the video on your Facebook wall and 
enjoy your friends’ comments or Likes.

Get your work seen on a host 
of social media outlets

Share with iCloud
Upload your files onto your iCloud for access over the web
Select the movie that you want to share by clicking on it in the Libraries panel. Go to 
File>Share>File. Choose a resolution and quality setting, then click Next. In the next window, 
click the drop-down menu and choose iMovie>iCloud. Click Share to upload your movie. A Share 
Successful message should appear. Log into your iCloud account in a browser and go to iCloud 
Drive’s iMovie folder. You can play your uploaded movies from there.

29

If you want to showcase your videos in an online portfolio, consider setting up 
a Vimeo account. This is the platform used by many video professionals.



30

A standard video clip plays 25 images every second. However, 
if you set your gadget (such as a GoPro or DSLR) to record one 
image every two seconds, then the action will play back at high 
speed. By using this time-lapse technique you can make clouds 
fly and people and cars flow like water.

Since the advent of iOS 8, your iPhone can record a time-lapse 
sequence at the press of a button. However, you can’t manually 
set the iPhone’s capture intervals and the clip will be a fixed HD 
resolution. By shooting with a GoPro or DSLR you can set the 
capture rate for faster or slower sequences and use iMovie to 
tweak colours and tones, as well as fine-tuning playback speed.

Difficulty 

Download available

Time needed

10

1 Use a tripod 
To create an effective time-lapse sequence 
you need a stable camera. The Muvi-Xlapse 
tripod has a mount for a GoPro or iPhone. It 
also rotates. 

2 Be patient 
Set your device to record. If you use a GoPro 
you can control it wirelessly using the GoPro 
app. This enables you to see the shots being 
captured without disturbing the camera.

3 Modify project properties 
Choose File>New Event, then File>New Movie. 
Choose No Theme. Label it Time-lapse. Click 
OK. Click on the Project icon. Set Photos 
Placement to Crop to Fill.

4 Import the assets 
Click Import Media. Browse to select our 
Timelapse assets. Click Import Selected. 
Still images will appear in the Event Browser. 
Select the images and drag to the timeline.

5 Change duration 
Click on a photo in the timeline and press 
Cmd+A to select them all. By default they 
have a duration of four seconds each. Click 
the i button and reduce the Duration to 0.1s.

6 Render the time-lapse movie 
Go to File>Share>File. Set Quality to Best 
(Pro Res). Untick Add to Theater. Click Next. 
Choose a location and click Save to render 
the high-quality version of the movie.

How to perfect a time-lapse sequenceStep-by-step

Shoot and edit a time-lapse movie
Speed up time and see the world in new ways thanks to iMovie

iMovie
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Speed up time
Modify the speed of your time-lapse movie

7 Import the rendered movie 
Create a new movie and import the high-
quality time-lapse clip you created. As the 
shortest possible duration of each photo was 
0.1s, the clip will look slow and jerky.

8 Re-time the movie 
To create a smoother time-lapse clip, click 
on the clip in the timeline and then click the 
Speed button. Set the Speed drop down to 
Custom and type in 200%. Hit Return.

9 Edit colour and tone 
Click the Color Correction icon and 
increase contrast, saturation and tweak 
the Temperature slider. Export your faster, 
smoother, corrected time-lapse movie.

 Source photos 
Our example time-lapse clip is created 
by snapping 200 shots on location 
at an interval of one photo every five 
seconds. When we run these stills 
consecutively in the timeline we get a 
high speed time-lapse clip (see ‘Edited 
Timelapse.mp4’).

 Fine-tune the speed 
By right clicking on a re-timed 
clip you can summon the Speed 
Editor. This enables you to drag 
here to speed up or slow down 
the clip until you’re happy with the 
speed of the action.

 Color correction 
By editing your time-lapse stills 
and clips in iMovie you can fix 
problems with exposure and 
colour balance using the Color 
Correction controls.

 Knowledge base
Shooting tips
If you shoot your footage 
using a DSLR camera, set 
the shutter speed, aperture 
and focus to manual. To 
speed up objects, choose 
a capture interval of one 
shot every two seconds. 
To capture the sun setting, 
set the rate to between five 
and 10 seconds. If you’re 
shooting one photo every 
two seconds, you’ll need 
around eight minutes of 
footage for a 10-second clip.

 Re-timed footage 
iMovie will only trim a photo down to 0.1 
second. To make your time-lapse footage 
play faster you need to export the stills as a 
movie, re-import the movie and then re-time 
it using iMovie’s Custom Speed editor.

If you want to shoot time-lapse footage on your GoPro, check out this handy 
time-lapse calculator at www.otus.co.uk/gopro.
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Start editing on iPad, and finish on Mac
Use all of your devices to create a stunning finished movie

iMovie

The extra power of the Mac
Using the fine-tuning controls in iMovie for Mac

Because iCloud and AirDrop enable all of Apple’s devices to 
connect to each other, iMovie now has an incredible new trick to 
help you make even better movies. If you own an iPad and a Mac, 
you can start editing on one device before moving to the other 
to finish your project. This means that you can shoot your entire 
movie using your iPad’s amazing camera (or even the iPhone 6s’ 
4K camera), then lay out the basics of your movie (with transitions, 
music and titles) on the touch screen. When you need more 
powerful editing tools, or want cool effects like green screen and 
animated maps, just transfer over to the Mac and you pick up right 
where you left off. Here’s how it’s done…

Difficulty 

Download available

Time needed
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 Audio control
You have decent control over audio 
on the iPad version of iMovie, but on 
a Mac you can fine-tune options like 
volume adjustments, and fade music 
up and down as you need it.

 Video stabilisation
The iPhone and iPad have some 
pretty nifty video-stabilisation 
tools built-in to help your videos 
look great, but you can make 
things even more steady with this 
option in the iMovie toolbar.

 Green screen
With the picture-in-picture 
options on Mac, you can use 
green screen functionality to 
overlay a person over the video in 
the background. It’s surprisingly 
easy, but is only available on 
iMovie for Mac.

 Knowledge base
Storage control
When you export your 
project on an iPad, you 
will need to have a fair 
amount of free space on 
your device. While you’re 
uploading your project to 
iCloud, the iPad also needs 
to store the file in its internal 
storage. If you get an error 
message, consider deleting 
files and apps that you no 
longer need – head into 
Settings>General>Storage & 
iCloud Usage.

 More speed!
If you want faster clips on your iPad, you’ll be 
limited to a 2x speed increase. On the Mac, 
you can make your clip as fast as you want 
– simply click this icon and then drag the 
slider in order to boost your speed!
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1 Get your clips
If you’ve recorded a lot of video on your 
iPhone, or saved clips to the Photos app on 
your Mac, you’ll be able to access it on your 
iPad – just download it from iCloud.

2 Start your project
You’ll now want to create a new project in the 
Projects tab. You’ll be prompted to choose a 
theme – you can pick any you like, as they will 
all be compatible with the Mac version.

3 Make your movie
Use the controls within iMovie to select clips, 
trim them, and add them to your project. 
Control things like the speed and volume by 
tapping the clip in the timeline. 

4 Prepare to share
When you have done everything you can on 
iPad, or just want to move over to the Mac 
version of the app, tap the Done button in the 
top-left of the iPad to return to this screen.

5 Share everywhere
Tap the Share button at the bottom to see all 
of your options. There are two main ways to 
share to Mac – through AirDrop, or by saving 
your project to iCloud Drive.

6 Choose project
Here, we’ve chosen to upload our video to 
iCloud Drive and access it on Mac. Remember 
to choose iMovie Project from this menu so 
you can edit it when you open it on a Mac.

7 Find and open
Now it’s time to move over to the Mac. Open 
Finder, select iCloud Drive from the sidebar on 
the left, then open the iMovie folder. When the 
file has downloaded, just double-click it!

8 Feel the power
You can now start utilising the extra editing 
power on the Mac version of iMovie. Take 
a look at the annotated image opposite for 
some ideas of what you can do! 

9 Finalise your project
When you’ve added all of the features you 
want – like animated maps – you can finalise 
your project and add it to iMovie Theatre, 
where it will be visible on all your devices.

Edit on any deviceStep-by-step

Sharing via AirDrop is easy, but you’ll need a Mac made in 2011 or later if you 
want to use this method. If your Mac is older, go for iCloud Drive instead.
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Photos

Keep your 
Photos library 
organised

Photos is the default app for all your iPhone pics, and 
chances are you’re going to be taking a lot of them thanks 
to the iPhone’s stunning camera. However, the problem with 
taking so many wonderful shots is that when you want to 
show them off to your friends and family, it takes an age to 
trawl through them all and find the one you want. 

Luckily Photos has a whole host of features that ensure you 
are never far away from your favourite photos, and you can 
sort them in a range of ways to keep your albums fresh and 
easily located. Here are just some of its options that mean you 
can snap away to your heart’s content without worrying you’ll 
never find that one amazing picture again.

Discover the top ten best ways to 
keep on top of your packed Photos 
library on your Mac 

Share 
your photos

One way to keep your 
photos in check is to 
share them on social 

media. Photos makes 
sharing your pictures 
very straightforward. 

Select the chosen 
photos or album, right-

click and hover over 
Share, then click on your 

preferred method.

Smart Albums
Smart Albums are a 

great way to get Photos 
to do your organising 

for you without any 
effort. Tell it to create an 
album based on certain 
criteria, such as photos 
that you’ve edited, and 

it’ll do all the legwork 
for you and stick the 

completed collection in 
the Albums folder.

Create 
new folders

While albums are a 
good way to organise 

your photos, sometimes 
you need a method to 
organise your albums, 

too! When in the Albums 
tab, right-click and 

choose Add New Folder. 
Name the folder then 
simply drag and drop 

albums into it.

Favourite 
your photos

If there are certain 
images in your Photos 

app you know you’re 
going to want to see 

again or just love to bits, 
hover over the photo 

and tap the little heart 
that appears in the top-

left corner. It will 
then appear in your 

Favorites folder. 

Create albums
Named albums are the 
best way to remember 
that special holiday or 

party. Select a bunch of 
photos by holding down 
Command and clicking 

on individual images, 
then tap on File>New 

Album and name your 
album. It will appear in 

the Albums menu at the 
top of the window.

Last import
This is another neat trick that Photos 
itself uses to help you keep track of 

your pictures. Click on the Albums 
tab and then on Last Import, which 

you should see on the top line of the 
menu. This will always keep your most 
recently added snap in place for quick 

and easy location.
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You get 5GB of free storage on iCloud before you have to start paying for it, 
so be careful how much you load onto your Photos account.

Inside your albums
Take a tour through the most important tab in your Photos app

 Shared photos
Remember which albums you have 
sent around via iCloud by tapping on 
the Shared tab. This will help you keep 
track of who’s seen what photos.

 Quick share
Share entire albums with your friends 
and family in only a couple of clicks by 
tapping on the Share icon in the top-
right corner and choose which method 
you want to use.

 Little and large
Whether you want to see a load of 
albums or just a few, you can move 
the slider here up and down, altering 
the size of the thumbnail images.

 Change slideshow themes
Alter how your images are displayed 
by hitting the Play button at the top of 
the window and select an alternative 
style, such as Vintage Prints or 
Origami to add some individuality.

 Knowledge base
Available extensions
Photos has already started 
to get some El Capitan 
upgrades. Image-editing 
extensions for Mac from 
MacPhun are already 
available to users with the 
latest OS X. These extension 
upgrades cover the Tonality, 
Intensify, Snapheal and 
Noiseless apps and will help 
you improve your pictures.

Search 
for photos
Using the same method 
to tag a photo as to add 
faces to it, include a 
description of a place or 
theme. That way you can 
use the search bar in the 
top right-hand corner of 
the window to quickly 
locate any photo that 
happens to include that 
particular tag.

Export images
As well as sharing your 
images to keep them in 
order, it might be worth 
exporting them to an 
external hard drive so 
they are in a portable 
format. Then, no matter 
what occurs, you have 
your albums safely 
backed up and in order. 
Hit File>Export then 
Export photos.

Sort it out
The easiest way to keep 
your albums managed 
and in check is to sort 
them in a particular way. 
Hit View>Sort and select 
your chosen option. So 
if you know the name 
of your album, sort by 
name and scroll to the 
required letter. 

Recognise faces
Just as with Facebook, you can tag 
people in Photos. All you need to do is 
double-click on a picture with people 
in, click the ‘i’ button in the top right-
hand corner and select Add Faces. 
The app will recognise faces so you 
can tag them. That information is then 
added to the Faces album. 
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When viewing a holiday snap on your camera’s small screen you 
may not notice sensor spots. These small grey blobs are caused 
by specs of dust on the camera’s sensor and they’re especially 
noticeable in contrast to a clear blue sky. Sensor spots can ruin 
a picture, so Apple’s Photos app provides you with a handy 
Retouch tool to automatically replace sensor spots with adjacent 
patches of clear blue sky. The Retouch tool is fine for this, but 
it’s not sophisticated enough to remove larger objects without 
leaving a noticeable patch. By installing MacPhun’s Snapheal 
extension into Photos (see boxout) you can make advanced 
alterations to your favourite images, such as removing objects.

Difficulty 

Download availableDownload available

Time needed

10

Photos

Retouch photos and clone out areas
Banish blemishes and remove unwanted content with the Snapheal extension in Photos

Remove unwanted objects 
Use the Snapheal extension to replace an object with appropriate pixels

 Selection tools 
You can select simple unwanted blemishes 
(such as sensor spots) using brush-based 
tools, or quickly select more complex shapes 
(such as a boat) using the Polygonal Lasso. 
Selected areas will appear in red.

 Precision 
If you’re in a rush or dealing with a simple 
sensor spot, the Norm button will do a 
quick job. To seamlessly remove complex 
objects you might need to use more 
processing power by clicking Highest.

 Erasing modes 
Choose the right algorithm for 
a particular erasing challenge. 
Twister is good for removing 
multiple sensor spots in the sky, 
Shapeshift tackles large objects 
(like a boat), while Wormhole is 
effective when retouching skin.

 Knowledge base
Avoid sensor spots
Sensor spots are annoying 
as you may have to remove 
them from multiple shots. 
Use your camera’s self 
cleaning menu (if it has 
one) to vibrate the sensor 
and dislodge any dust. If 
you have a DSLR you can 
remove the lens and give the 
sensor a puff of air using a 
blower brush. Check your 
camera’s manual for details 
on how to do this safely.

 Before and after 
Click the eye-shaped icon to toggle between 
the original image and the edited version. 
Alternatively click the adjacent icon to view 
both versions side by side. This helps you 
see how your retouching is shaping up.
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1 Use the Retouch tool
Open a photo, click Edit>Retouch. Adjust Size 
so the brush is larger than the spots. Spray 
over each spot to remove it. Alt-click to pick a 
sample area to replace an unwanted spot.

2 Launch Snapheal 
The Retouch tool lacks the ability to replace 
complex objects such as this boat, especially 
if it overlaps a texture like the ocean. Click the 
Extensions icon. Choose Snapheal.

3 Remove sensor spots 
In the Erase panel, pick the Brush tool. Adjust 
Diameter to make it larger than the spots. 
Choose the Twister erase mode, set Precision 
to Norm, click each spot and then click Erase.

4 Remove bigger objects
Choose the Polygonal selection tool. Click 
to draw straight lines around the unwanted 
object and some surroundings. Place the last 
point on the first to complete the selection.

5 Adjust blend settings 
Set the Erasing Mode to Shapeshift to deal 
with complex backgrounds. Set Precision to 
Highest for a seamless blend. Click Erase! 
These settings take longer to process.

6 Fine-tune the erased area 
To help blend the patched area with nearby 
pixels, click Clone. Reduce Opacity to 50. 
Alt-click to sample an area and spray it over 
edges to blend them with the rest of the shot.

Remove unwanted objects and artefactsStep-by-step

Snapheal’s Retouch panel enables you to make selective brush-based 
adjustments to colours and tones, which gives Photos even more functionality.

Increase the functionality of Photos by installing third-
party apps as extensions. Since these extensions can be 
accessed from within Photos, you can use them without 
interrupting your workflow. The Snapheal extension gives 
you the ability to make advanced healing and cloning 
adjustments because it is ‘content-aware’. Its advanced 
algorithms can replace an unwanted object (such as the 
boat in our example) with appropriate textures (the sea) and 
blend the retouched area seamlessly with its surroundings. 1 Download Snapheal

MacPhun’s Snapheal app will work as a 
standalone app as well as an extension in 
Photos. You can buy it from the Mac App Store 
for £10.99/$14.99. Click Buy App and enter your 
Apple ID to download it to your Mac.

2 Select Snapheal 
Once the Snapheal app has downloaded, launch 
Photos. Click the Edit button. Click the Extensions 
icon and choose More. In the Extensions panel, 
click on Photos. Click the box next to the 
Snapheal extension to select it.

Installing Snapheal 

“The Snapheal extension gives 
the ability to make advanced 
healing and cloning adjustments”
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Learning to play an instrument is an incredibly rewarding struggle. 
Practise makes perfect, and most begin by attempting to master 
the fundamental techniques before advancing. Aside from 
merely recording and mixing your compositions, GarageBand 
acknowledges this vital learning stage by providing exercises 
for guitar and piano. As part of its Learn to Play feature, the 
app offers 38 free modules ranging from beginner to more 
advanced. Budding guitarists can learn basic chord shapes and 
fundamental progressions, while practising pianists can learn 
classical and pop styles. Beyond basic tutelage, the Play chapter 
invites you to perform and record to monitor progress.

Difficulty 

Download available

Time needed

20

1 Finding lessons 
Guitar and piano lessons are listed under 
the Learn to Play tab of GarageBand’s New 
Project dialog. They appear here after being 
downloaded via the Lesson Store tab below. 

2 Open a lesson 
With lessons downloading or available, simply 
select the one you wish to open and double-
click or hit the Choose button to begin. The 
lesson will open and start full screen. 

3 Meet the teacher 
A teacher who instructs directly from a main 
window hosts each lesson. You can toggle 
pause or play via the controls found at the 
bottom or skip/scrub forwards and back.

4 Advanced playback 
Beyond basic transport controls, clicking the 
chapter markers skips progress. Toggle on the 
yellow cycle region via the loop button or slow 
playback with the slider.  

5 Input monitoring 
With guitar or MIDI keyboard interfaced, you 
are invited to play along and monitor output. 
The light next to the metronome glows red to 
indicate input signal. 

6 Play chapter 
Hover over the Teacher pane to switch to the 
Play chapter. Here you can use the Record 
button to capture your playing and grade 
progress with the ‘How did I play’ feature.

Learn an instrument in GarageBandStep-by-step

Learn how to play with free lessons 
Discover how GarageBand provides guitar and piano tutelage no matter what level 

GarageBandGarageBand
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Teacher’s pet
Familiarise yourself with the main interface elements and tools

7 Guitar tuner 
During guitar lessons, you can access a tuner 
from the menu in the top right. Here you 
can click each individual string to pluck and 
monitor to get tips on fine-tuning.

8 Mixer controls 
Pick the Mixer menu option to view a series 
of sliders for setting the teacher’s voice and 
instrument volume, the accompanying band 
and your own instrument or recordings.

9 Setup options 
The Setup options provide controls for 
choosing instrument inputs and toggling 
monitoring. Personalised lesson options for 
notation and instrument are also found here.

 Instrument and notation 
Below the teacher you will find either 
a guitar neck or set of piano keys 
– depending on the lesson type – 
indicating associated finger positions. 
By default you will automatically see 
music notation appear above this 
where required. 

 Chapters and controls 
At the bottom of the lesson 
is a duration bar with chapter 
markers. Here you’ll notice a 
playhead moves along to denote 
progress, while below are 
controls for playback alongside 
speed and volume sliders.

 Lesson menu 
This top menu houses a 
Glossary of technical and 
musical terminology and a handy 
tuner for guitar. The Mixer has 
volume controls for varying the 
component audio levels, while 
Setup defines preferences for 
inputs and lesson behaviours.

 Knowledge base
Artist Lessons
Another technique favoured 
by fledgling musicians is 
to emulate their heroes by 
learning popular songs. 
Artist Lessons extend Learn 
to Play by delivering music 
stars like Sting, Norah Jones 
and John Legend as your 
own personal tutors. Each 
explains guitar and piano 
techniques behind playing 
their most successful hits 
and must be purchased from 
within GarageBand.

 Teacher window 
This is the main panel where the teacher 
addresses you and demonstrates the 
featured techniques as you follow. Hover 
over this to switch between Learn and Play 
chapters, or toggle focal points. 

Lessons play full screen so you may be unsure of how to exit. To quit a lesson 
click the cross icon (x) in the top-left corner.  
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Generating original rhythm tracks in GarageBand always tended 
to hinge on editing loops or capturing MIDI-based drums. 
However this has all changed with the Drummer feature, offering 
a selection of virtual players across popular styles. Simply add 
a Drummer track and the performance fits the project, providing 
an organic accompaniment for neighbouring tracks. A number 
of custom track editing controls are then used to reshape drum 
patterns, styles, percussion options and timing for achieving 
unique results. In addition, Drummer tracks boast Smart Controls 
for adjusting the sound of the individual drums, applying more 
attack or tone to kick drums, snare, hi-hat, toms and much more.  

Edit how the automated Drummer tracks appear within your project 

Swapping patches within the Library 
panel provides Smart Control presets 
and the Drummer track editor allows for 
variable instrumentation.

1 Drummer track
To start, you need a Drummer track (yellow) 
within your project. If you need to add, then do 
so via Track>New Track, click the Drummer 
icon and click the Create button. 

2 Mix controls
With Drummer track selected, show Smart 
Controls. The Mix dials raise volume or attack 
of each part of the kit while the glowing 
buttons to the right toggle on or off.

3 Compression control
Compression basically ‘tightens’ or sharpens 
the drum sound overall. With this control you 
can toggle it off completely or layer on more 
by rotating the dial clockwise. 

4 Effects controls
Each kit features two Effects controls. The 
first raises Tone to make each drum element 
feel richer, before Room adds a more spatial 
sound to increase resonance.  

Use controls to shape a Drummer’s sound Step-by-step

1 Switching patches
You can switch between Library patches for 
Drummer as you would with any other track, 
swapping between Drum Kit patches and 
customising again via the Smart Controls.  

2 Drummer Editor
With Drummer track selected, show the Track 
Editor panel. Here you will find a set of three 
sliders for changing the amount of Percussion, 
Hi-Hat, Kick and Snare.

Customising kits

Difficulty 

Download available

Time needed

10

GarageBand

How to shape a Drummer’s sound
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Logic Pro X

Reshape sound with the Transform Pad 
Apply incredible morphs to any synth you have with this nifty Alchemy tool in Logic Pro

The inclusion of Alchemy in the Logic Pro update is something of 
a double bonus for synth fans. Its innovative Transform Pad, which 
enables users to smoothly morph between eight different snapshot 
versions of the same preset, has been added to Logic’s list of 
Smart Controls layouts, providing a faster alternative to opening 
the synth’s plug-in window and tweaking individual parameters. 
What’s really cool, though, is that you don’t have to be using 
Alchemy to take advantage of this amazing feature – the Transform 
Pad layout can be used with any synth you have at your disposal, 
as long as you don’t mind a little initial tinkering to set it up to your 
liking. Here’s how to get it up and running on your own system.

Difficulty 

Download available

Time needed

20

Transformation! 
Explore brave new soundscapes with the Transform Pad 

 Open says me 
Click the Open button to reveal a 
window in which the response curves 
and minimum and maximum value 
ranges of the mapped parameters can 
be adjusted.

 Zoom 
To get the Transform Pad showing 
at full size, close down other 
edit windows and panes such as 
the Inspector and Library panes 
and the Media Browser. The 
Transform Pad will then occupy 
the full width of the screen.

 Controls button 
Click this to reveal ten rotary 
encoders and two X/Y pads 
that can also be mapped to any 
parameter and automated. These 
get assigned when you select the 
Map all Controls option covered 
in step 8.

 Knowledge base
Stay with me
When you make an 
assignment, or set of 
assignments, for a particular 
synth in the Smart Controls 
window, they’ll stay in 
place when you change 
presets on that synth. This 
is great for setting up your 
desired parameters and 
then scrolling through the 
synth’s preset library to see 
how moving the Transform 
Pad reticule will affect each 
sound in turn.

 Reticule is nothing to 
be scared of 
The movement of the Transform 
Pad’s blue reticule can be 
automated. Just switch the 
track’s automation mode to 
Latch, hit Play and record your 
moves. Switch automation back 
to Read to play them back.
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1 Show advanced tools
For Smart Controls to be accessible, you 
first need to enable Logic’s Advanced Tools. 
Select Preferences>Advanced Tools and tick 
the Show Advanced Tools checkbox.

2 Load Alchemy
Click the + button at the top of the track list, 
then click the Software Instrument button and 
choose Alchemy from the pop-up Instrument 
menu. Click Create.

3 Launch Smart Controls 
Choose a preset – we’ve gone for Cream 
Unison. Click the Smart Controls button in the 
toolbar to access the Transform Pad without 
opening the synth’s window.

4 Have a drag 
Play the synth (or use the included Cream 
Unison.mid MIDI file) and drag the blue 
reticule around the Transform Pad to hear the 
dramatic effect it has on the sound. 

5 Load new synth
Import the Fat Square Bass.mid MIDI file onto 
a new Software Instrument track. Then load 
Logic’s ES P synth and select the Fat Square 
Bass preset. 

6 Open Inspector
Note that the Smart Controls layout for the 
ES P is different to Alchemy’s. To access the 
Transform Pad, click the ‘i’ button to reveal the 
Smart Controls Inspector pane.

7 Select layout
Mouse over the Automatic Smart Controls 
text and click to reveal the Layout menu. The 
Transform Pad is labelled here as Modern 
Synth 2 tab. Click to select it.

8 Map parameters
Click the gear icon and select Map all 
Controls. This assigns mappable parameters 
onto the Transform Pad’s two axes, as well as 
onto the rotary controls to the right.

9 Learn mode 
To map a particular control, click the Learn 
button, select the axis you want to assign the 
control to, then click the control in the plug-in 
window. Click Learn again to exit. 

Set up the Transform PadStep-by-step

Open the Smart Controls in a separate window by choosing the Open Smart 
Controls option from the Window menu.
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Video cameras tend to process footage so colours look as 
they did to the naked eye. This can make your footage look like 
everyone else’s. To create distinctive colours, TV programmes 
run a grading process. This involves adjusting hue and saturation 
to produce a particular look. In the 1990s, graded shadows 
were crushed so no detail was visible, while the saturation was 
increased to create vibrant colours. Today many dramas are 
graded so there are no 100% black shadows in the frame. The 
hue of the blues is shifted to create cyan skies, mimicking cross 
processed film. We’ll demonstrate how to use Final Cut Pro X’s 
Color Board to take control over colour and tone.

Difficulty 

Download available

Time needed

20

1 When to grade 
You should only grade footage once you’ve 
completed the edit. This saves you wasting 
time grading colours and tones on clips that 
don’t end up in the final cut of the programme.

2 Show the Inspector 
Click to select a clip in the Timeline. Here we 
have an unprocessed shot with flat tones and 
weak contrast. The colours are a bit drab, too. 
Choose Window>Show Inspector.

3 Go to Color Board 
Choose Window>Go To>Color Board. The 
Color Board will appear in the Inspector. Click 
on Exposure. Drag the Shadows down to 
-13% for stronger contrasting shadows.

4 Create vibrant colours 
Click on Saturation. You could boost all the 
colours equally by dragging the Global slider 
upwards. Here we’ve selectively dragged 
Midtones to 31% and Highlights to 18%.

5 Adjust the hue 
We now have richer colours and a stronger 
contrast, so we could stop our grading at this 
point. However, to produce a more creative 
look, click on the Color icon to adjust Hue.

6 Make a global adjustment 
To change the hue of the shadows, midtones 
and highlights simultaneously, drag the Global 
control point. Here a value of 50 degrees at 
19% creates a warm summery look.

Adjust hue, saturation and toneStep-by-step

Master the art of colour grading
Change the mood of a shot by adjusting hue and saturation

Final Cut Pro X
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Composite clips 
Selectively adjust a clip’s colours and tones to grade it

7 Cool down the shadows 
Click the arrow-shaped Undo icon to restore 
the original hue values. By pushing the 
Shadows control point directly up by 27%, you 
can add a cooler wash to the clip’s shadows.

8 Tint the shadows 
By dragging the Shadows control point left 
towards the green part of the spectrum (at a 
value of 143 degrees for example), you can 
shift the shadow hue towards a greener tint. 

9 Use negative values 
Selectively tint shadows, midtones and 
highlights by dragging control points down. 
Here a midtone value of -45%, 142 degrees 
adds a magenta tint to the midtones.

 Control points
In the Color panel you can adjust the 
hue of particular tones by dragging 
their control points. Here the Shadows 
control point has been dragged over 
the green section of the spectrum to 
add a green tint to the darkest areas.

 Preserve the whites
In our example we’ve added a 
magenta tint to the midtones 
and a green tint to the shadows. 
By leaving the Highlights control 
point at its default settings, we’ve 
managed to keep the brightest 
whites looking white.

 Improve exposure
This icon gives you access to 
tone-tweaking tools. You can 
selectively adjust the tones 
of a clip’s shadows, midtones 
and highlights by dragging the 
appropriate control points up or 
down (see Step 3).

 Knowledge base
Shoot to grade
Your camcorder or DSLR 
might have presets that 
produce a range of looks. It 
can be hard to grade a clip 
if it already boasts vibrant 
colours and tones. Some 
information may be missing 
in the darkest shadows or 
brightest highlights. Shoot 
on a Neutral setting to 
preserve detail and capture 
neutral colours. This will give 
you more choice and control 
in the post-production stage.

 Adjust saturation
If your clip suffers from drab colours you can 
boost the Global Saturation using the tools 
in this section of the Color Board. You can 
also boost saturation selectively by targeting 
shadows, midtones or highlights (see Step 4).

After grading a clip, click it and choose Edit>Copy. Click on a new clip and 
choose Edit>Paste Attributes. Tick Eff ects to apply the same grading settings.
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Font Book

Manage your typefaces with Font Book
Learn how OS X’s own Font Book app can assist better typeface management

Hands up all those who know what font management means. 
Nobody? Well on the Mac and within OS X, good font 
management should extend beyond dropping new typefaces into 
the Library>Fonts folder. There’s also little excuse for failing to take 
greater care of these licensed assets thanks to OS X’s Font Book 
app. This handy system utility is found within your Applications 
folder and automatically lists all installed typefaces, itemising 
families between Computer and Users. From here you can easily 
preview styles and crucially enable or disable fonts to control 
access. New collections and libraries can also be created, fonts 
exported, validated and any detected duplicates turned off.   

Difficulty 

Download available

Time needed

20

Font Book explained 
Pick out, identify and recognise the core areas of the Font Book app interface 

 Collection column
This panel shows font collections, 
along with all fonts or those divided 
between computer and user. The 
buttons above toggle the preview 
shown in the main panel while the plus 
(+) button adds a new collection.

 Font list 
Associated fonts are listed 
alphabetically within this panel, 
depending on the selected 
collection. Click a listed family 
to expand and show installed 
variants. The buttons above add 
new fonts or disable them.

 Preview editing 
The main font preview can 
be edited, changing the text 
as desired. In addition, sizing 
controls include a drop-down and 
slider control for adjusting the 
size of the styled typography.   

 Knowledge base
Resolve duplicates
Font Book scans your 
installed library to find any 
duplicates, placing a yellow 
warning symbol next to 
them. Choose Edit>Look 
for Enabled Duplicates 
and then click to Resolve 
Automatically or Manually. 
Resolve Automatically takes 
action based on preferences 
while Manually offers 
choices for reviewing and 
then resolving by sending 
inactive copies to the Trash. 

 Font Previews 
Selected font families and variants are 
previewed in the main panel, depending on 
the output options above the Collections 
panel. Double-clicking a listed font shows a 
floating preview box you can toggle between.
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1 Finding Font Book 
Font Book is found in the Applications folder, 
and launched via the Dock, Launchpad, 
Spotlight, through Finder’s Go>Applications or 
by simply double-clicking a font file.

2 Previewing fonts 
Firstly, Font Book is useful for previewing 
fonts. Font files are previewed by Font Book 
on a double-click, while installed fonts are also 
shown in Font Book’s main panel. 

3 Font collections 
Installed fonts are shown in the first panel 
alongside Collections. Collections group 
together chosen fonts for better access. Click 
it to see the collected fonts on the right.

4 Create collections 
Click the plus (+) button found in the bottom-
left corner to add a new collection. Type a 
name before clicking All Fonts to drag desired 
fonts into the new collection. 

5 Smart Collections 
Right-click to rename, disable or delete a 
collection. Smart Collections can also be 
created via File>New Smart Collection to build 
selections defined by multiple rules.

6 Install or disable 
New fonts are installed by clicking the plus (+) 
button above the second panel and locating 
the file. The button alongside disables fonts to 
deny access without deletion.

7 Multiple typefaces 
Font families often contain multiple typefaces 
such as Regular, Italic or Bold. Hover over 
a listed font to see how many typefaces it 
contains or expand via the item arrow.

8 Validating fonts 
Choose File>Validate Font with a font selected 
to review errors and resolve within the Font 
Validation window. Font files can also be 
validated via File>Validate File. 

9 Restore fonts
When encountering issues with installed fonts, 
File>Restore Standard Fonts reverts Mac 
system fonts to original states and places any 
added fonts into a Removed folder.

Take control of your fontsStep-by-step

Fonts are stored locally within OS X inside the Library>Fonts folders for all 
users on Macintosh HD and then those for each system user account.
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1 Start CleanMyMac 
Click CleanMyMac in the Applications folder 
and when it starts, select Photo Junk in the 
left panel. This ignores the other junk files and 
focuses on just the Photos app.

2 Select the library 
For many people CleanMyMac will select the 
Photos library automatically. Other users might 
store it elsewhere, such as an external disk. 
Click Change Library and select it.

3 Scan for junk 
Click the Scan button at the bottom of the 
screen and wait until it finishes. Although you 
could click the Clean button, click Review 
Details to see what it has found.

Optimise Photos with CleanMyMac 3
CleanMyMac 3 is a great disk clean-up tool that finds junk and 
unnecessary files. It is a general tool that cleans all parts of the 
system, but this tutorial focuses on its ability to optimise the 
Photos library containing digital camera and phone photos. 
Whenever a photo is edited, the Photos app keeps the original 
image, makes a copy and performs the action on the copy, such 
as rotating it, adjusting the brightness, contrast and so on. This 
means that multiple copies of the photo are stored on disk, which 
wastes space. CleanMyMac scans the Photos library, finds these 
duplicates and lets you delete them to free up disk space. It does 
not delete anything you need, but it is wise to have a backup.

Recover lots of wasted disk space in your Photos library

4 Select the caches 
The Photos app creates temporary files 
and stores them in caches. These are not 
important and they can be removed. Tick the 
two caches to select them for deletion.

5 View RAW images 
Not all cameras save RAW images, but if 
yours does you will have a lot of very large 
files. Select RAW Originals and tick the RAW 
images you would like to remove.

6 Ignore your favourites 
There may be some original RAW images that 
you prefer to keep because they are valuable. 
Right-click the thumbnail images and select 
Add to Ignore List to skip them.

Find and remove unnecessary photosStep-by-step

CleanMyMac 3

Difficulty 

Download available

Time needed

10
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CleanMyMac only selects the Photos caches by default and these are safe to 
delete. Caches are rebuilt when using Photos, so clean them often.

A tour of CleanMyMac’s features
Get to know the CleanMyMac interface

 Find Photos junk
A Smart Cleanup will find and 
delete unnecessary photo files, but 
it is better to select the Photo Junk 
function because it provides more 
features and more control over what 
is deleted.

 Keep or delete?
Tick boxes on the RAW image 
enables you to select which ones 
to delete (ticked) and which to 
keep (clear). The amount of space 
used by each RAW image is 
displayed and they are big.

 Resize the thumbnails
This slider in the top-right corner 
enables you to change the size of 
the thumbnails displayed when 
browsing the RAW photos. Drag 
the slider to the right to increase 
the size.

 Knowledge base
How to install 
CleanMyMac
CleanMyMac can be 
downloaded from 
cleanmymac.com. Double-
click the .dmg file to open it 
and then drag the app to the 
Applications folder. Security 
settings may prevent it from 
running, so go to System 
Preferences>Security & 
Privacy and select the 
General tab. Click the 
padlock and enter the 
administrator password. In 
the ‘Allow apps downloaded 
from’ section, select the 
Anywhere option.

 RAW originals
Should you tick this and delete all RAW 
originals? The advantage is that lots of disk 
space is recovered. The disadvantage is that 
the original photos are lost. You might want 
to keep them.

7 Use Quick Look
Right-click a RAW image and select Quick 
Look if you want to check it. The original RAW 
image is shown on the left and the JPEG that 
can replace it is on the right.

8 Configure Smart Cleanup 
Go to the CleanMyMac menu and select 
Preferences. The Smart Cleanup function can 
be configured from here. Tick or clear the 
Photo Junk box to include or exclude it.

9 Use Smart Cleanup
Smart Cleanup is a one-click clean up of the 
whole system and if Photo Junk is ticked in 
Preferences, then the Photos library is cleaned 
along with everything else. 
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Commander One

Replace Finder with Commander One
Use an alternative file manager to browse, access and control content

Finder is a fine tool for exploring the disk drive, running applications 
and opening files of all types. However, it is not the only tool 
available and there are others, such as Commander One (mac.
eltima.com/file-manager.html). This free utility does everything in 
Finder and it has extra features, too. The most obvious of these is 
the dual pane display. Two drives or folders are shown side by side 
and files can easily be copied or moved from one to the other. For 
people that like to keep their hands on the keyboard, key strokes 
perform file and folder tasks in a flash. Another great feature is that 
zip files can be opened like folders, the contents viewed and files 
copied out without unzipping the archive.

Difficulty 

Download available

Time needed

10

Use Commander One features
Perform file operations and searches

 View hidden files
Click this switch to view hidden 
files and folders. It can be useful 
for exploring the Trash folder, which 
is normally inaccessible, and other 
invisible items that have been created 
by OS X and applications.

 Right-click menu
Right-click a file or folder to access 
a menu with useful functions. 
Get Info shows information 
about the file such as sharing 
and permissions. Use the other 
functions to view, edit, or rename.

 Add tabs
In addition to having two panes, 
you can have multiple tabs. Click 
the plus button and navigate to 
a new folder to open a tab with a 
different view. 

 Knowledge base
Hidden files
Unlike Finder, Commander 
One enables you to see 
hidden files. Their names 
start with a dot and they 
appear in light grey to 
distinguish them from 
ordinary files. It is definitely 
best not to delete them, 
move them or modify them 
unless you know what you 
are doing because they may 
be system files or used by 
an application.

 Search for files
Spotlight is fine for some things, but not 
others. Click this button to search the disk 
for files. It looks in places Spotlight ignores 
and so can find items Spotlight misses.



53

1 Select a disk
There are two panels – each is used to view 
a different disk or folder. Click the drive list 
above a panel and select a disk. Double-click 
folders to explore the disk.

2 Select and copy
Tap spacebar to select a single file, or hold 
down Shift and press the up or down arrow 
keys to select several. Press or click F5 to 
copy the files from one side to the other.

3 Queue file operations
Copying or moving large files could take 
some time. Click the Queue button to view 
the progress of tasks. Carry on copying and 
moving files and add them to the queue.

4 Open zip archives
Double-click a zip archive to open it like a 
folder, or select it and press Enter. You don’t 
need to extract the contents, just use Copy> 
F5 to copy the files out.

5 Use the menu
Right-click a file to display a context menu 
with useful functions. Select Rename to 
enter a new name, use Get Info, Quick Look, 
Compress and so on, just like Finder.

6 Compress files
Select some files, click the zip button in 
the toolbar and then set the amount of 
compression. It can squeeze files into a 
smaller space than Finder can.

Copy, move and delete filesStep-by-step

The two panels and the columns can all be resized. Let the mouse hover over 
the column separator and then click and drag left and right.

Commander One is useful for file operations between 
computers over a network. Copying large files can be slow 
and tedious with Finder, but the option to queue operations 
in Commander One means you can define several actions, 
such as copying and moving files, and then leave them 
running in the background. You can connect to other Macs 
or even Windows PCs over a wireless network. Here’s how. 1 Browse the network

Click the Network button at the top or select 
Network in the drives list. The other computers 
appear in the right or left panel as icons or text 
listings depending on the view. Here is an HP 
laptop running Windows.

2 Connect to computers
Double-click a network computer to connect to it. 
It depends on the security settings, but you might 
need to log in with a username and password 
from an account. Then browse the contents and 
perform all the usual file tasks.

Connect to 
network drives

“The option to queue operations 
means you can define actions 
and then leave them running”
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An underrated and overlooked aspect of the Apple TV is the 
wonderful screensaver. If your telly has been idle for a while, it 
will default to a stunning sweeping aerial view of the Oakland Bay 
Bridge in San Francisco. If you, like us, are a big fan of video, you 
can now download it onto your Mac so you can enjoy the sight 
of this beautiful two-storey bridge whenever you’ve been away 
from your computer for a while. This tutorial will show you how to 
download the zipped file from GitHub and set it as your default 
screensaver option. It will also take you through the steps needed 
to download something from an unverified source if your security 
preferences have been set to only allow App Store downloads. 

Difficulty 

Download available

Time needed

10

1 Download software 
Download Aerial from GitHub by heading to 
github.com and searching for Aerial. Scroll 
down to the Installation menu and click on the 
link to download it onto your Mac.

2 Open it up 
Open the Downloads folder and find the file 
entitled ‘Aerial.zip’. Tap on that and the folder 
contents should be automatically unpacked 
and will be saved as ‘Aerial.saver’.

3 Open Aerial saver 
Double-tap on ‘Aerial.saver’ or right-click and 
select Open. This second option can bypass 
some of the security features you may have on 
your Mac. This will open up a Settings menu. 

4 Set your screensaver 
Scroll down to the bottom of the options that 
have appeared on your screen. You will see 
the option marked Aerial on the left-hand side 
of the menu. Select it.

5 Set preferences 
Tap on Screen Saver Options and the range 
of screensaver cycles it will go through will 
appear on the left. Untick cycles you don’t 
want it to go through and then hit Done.

6 Set random screensaver 
You might not want the sweeping skylines of 
the world’s major cities every time, so if you hit 
Random at the very bottom of the window, it 
will select the screensaver for you. 

Download Apple TV screensavers to a MacStep-by-step

Get  TV screensavers on your Mac
Put the gorgeous aerial shots from your Apple TV onto your Mac 

System Preferences



55

Screen Saver options
Personalise your new and improved screensaver

 Alter timings 
Your screensaver is set to turn on after 
20 minutes of inactivity, but you can 
change this using this menu. You can 
go as low as a minute or as high as 
an hour.

 Show with clock
The loss of the clock in the corner 
of your screen when in Screen 
Saver mode can be an irritation, 
so tick the box marked Show with 
Clock to have the time displayed.

 Hot corners
Set one or more corners of your 
screen as Hot Corners by hitting 
this menu. This means you can 
go straight to your screensaver by 
moving your cursor to that corner 
of the screen. 

 Knowledge base
Battery saving
If you’re downloading 
this screensaver onto a 
MacBook Air or any other 
Apple product that runs on a 
rechargeable battery rather 
than mains power, Live 
Wallpapers come at quite a 
high battery cost. If you’re 
using a desktop Mac, then 
this won’t be a problem.

 View preview 
To see what the screensaver will look like on 
your Mac before you set it, hover over the 
large image. It will flash up an option to see a 
preview, so tap on that. 

GitHub is a website that lets users share code with other users in an easy and 
accessible way. Be wary of rogue code when using it, though.

Your Mac will be automatically set up to only accept 
downloads from the App Store. However, as this is a 
GitHub download, your Mac will block it from being added. 
Luckily it only takes a couple of steps to enable downloads 
from other sources. However, once you’ve downloaded 
Aerial it might be worth changing the settings back to be 
on the safe side and avoid genuinely harmful apps. 1 Unlock Security settings 

Click on the Apple logo in the top-left corner of 
your screen. Select System Preferences from the 
drop-down menu and then choose Security & 
Privacy from the top line. Click on the lock in the 
bottom-left corner to enable changes.

2 Change app settings
The menu that was greyed out before will now 
be normal. Click on the option to allow apps 
downloaded from anywhere and you will be able 
to complete the download of Aerial. Hit the lock 
again to prevent any further changes.

Bypass the 
security features

“Luckily it only takes a couple of 
steps to enable downloads from 
other sources”
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Turn your finger into an eraser
No eraser on the Apple Pencil? Never fear, your finger is here!

1 Enter the Settings
Download the Procreate app from the App 
Store. You don’t need to open it quite yet, 
however. Head to the Home screen of your 
iPad Pro and tap on the Settings icon. 

2 Procreate settings
Scroll to the bottom of the Settings menu 
where you will find the Procreate menu. Tap 
it to bring up all the settings options for that 
app, one of which is Finger Mode. 

3 Set Finger Mode
Tap on that menu and you will be given all 
the actions you can perform in Procreate with 
your finger. You can use it to paint or smudge, 
but for this tutorial, select Erase Only.

Erase all of your mistakesStep-by-step

Difficulty 

Download available

Time needed

10

Procreate

The Apple Pencil is a wonderful piece of kit but it does have 
a small oversight. While one end acts as a stylus, perfect for 
writing and creating intricate pieces of art, the other end has no 
benefit. Seeing as it’s called the Apple Pencil, fans have been left 
wondering why there isn’t an eraser tool on the other end that 
could rub out any mistakes made while using the device. 

For an artist’s tool, the lack of an eraser is a bit of a 
disappointment, but just like Steve Jobs said in that famous 
stylus-bashing speech in 2007, we’re going to use the best 
pointing device in the world, a pointing device we were born 
with. Our finger. If you have the Procreate app installed on your 
iPad Pro you can set your finger to act as an eraser, so you can 
quickly scrub out any mistakes without having to tap the Eraser 
icon and spoil your creative flow.

This only works for the iPad Pro, as that’s the only device the 
Apple Pencil is currently compatible with, and the Procreate 
app, as the setting is for the app itself, rather than in the iPad’s 
options. This tutorial will take you through how to set your finger 
up as an eraser using Procreate on the iPad Pro and then use it 
to get rid of any slips of the pencil.
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4 Draw your picture
Open up the Procreate app and begin to draw 
your artwork using the Apple Pencil. Try not 
to touch the screen with your hand otherwise 
you will accidentally erase your handiwork.

5 Erase images
If you have made a mistake or want to change 
something, place any finger on the screen 
and rub the area. The area in question will be 
whited out so you can improve your work.

6 Remove smaller errors 
The top slider on the left controls the size of 
the eraser strokes. To be more precise with 
your rubbing out, slide this downwards or to 
be more general, swipe it up. 

Extra erasing
Further tips for making 
sure no one gets to see 
your mistakes

 Layers
The blue circle in the top right-hand 
corner of the screen activates the layers. 
If you have a multi-layered image, 
rubbing with the eraser reveals the 
picture below.

 Undo and redo 
The two arrows below the sliders on the 
left-hand side of the screen undo and 
redo the actions of the eraser. If you want 
to undo other actions, tap the arrow at 
the top of the screen.

 Set eraser opacity
The lower slider on the left-hand 
side of the screen increases 
and decreases the opacity of 
the eraser, so if you just want to 
partially hide something, pull the 
slider downwards. 

 Always an eraser
When Erase Only is selected, no 
matter which of the top right-hand 
icons are selected, your finger 
movements will always act as if it 
is an eraser. 

 Knowledge base
Alternative finger 
settings
If you don’t want to use your 
finger solely as an eraser, 
there are a number of other 
functions it can perform. 
You can use it to smudge 
images, paint, use any of 
the selected tools in the top 
right or just gesture control. 
The advantage of selecting 
one particular mode is to 
avoid accidentally painting 
when you meant to erase.

You can set the Apple Pencil to Erase Only if you like, as well as Smudge, 
Paint and Selected Tool. The only thing it can’t do is gestures.



Cut out and blend 
images on your iPad

Photoshop Mix is a wonderful, free app that enables you to take 
multiple images and blend them together to create a single, jaw-
dropping photograph by layering one over the top of the other. 
The trouble with layering images is that sometimes aspects 
on one photo detract from the rest of the image, creating a 
confusing, unattractive result. 

Photoshop Mix has an intuitive workflow. The app gives you 
the option to cut out certain areas of a particular photo so you 
have the control to layer just the part you want onto the other 
picture, creating a clean and tightly-blended image. There are 
plenty of other features in this creative app beyond just cutting 
and blending, for example you can also add filters and different 
styles to your images and change the opacity level before 
blending them together. This tutorial will show you how to cut 
out and then blend two or more images together to make a truly 
original picture.

Create incredible blended images with Adobe’s free 
and powerful Photoshop Mix app

Create bespoke imagesStep-by-step

Difficulty 

Download available

Time needed

20

1 Choose an image
Download Adobe Photoshop Mix from the 
App Store (http://apple.co/1PaVSTY) and 
sign in with your Adobe ID. Tap the plus sign 
on the left-hand side of the screen to open up 
your Camera Roll.

2 Open your image
Select your main image from the Camera 
Roll by double-tapping it. Once it appears 
on your iPad’s screen, edit it if desired using 
Photoshop Mix’s built-in filters along the 
bottom row of the screen.

3 Open secondary image
Tap on the small plus on the right-hand side 
of the screen to open up your Camera Roll 
again and then select the image that you want 
to blend your main image with. You do this by 
double-tapping it.

Photoshop Mix
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7 Feather image
Tap and hold on the Feather icon at the 
bottom of the screen and drag the slider up 
to graduate the edges of the cutout. This will 
provide a more natural blend, which is exactly 
what we’re after.

4 Quick blend 
To simply layer the two images together, select 
one of the preset options at the bottom of the 
screen and your two pictures should combine 
in the main preview area, with the original 
image being dominant.

8 Blend in
Now you should be able to blend your cutout 
and feathered image more satisfactorily with 
the main image by pressing on the Blend 
option and increasing the Opacity setting of 
the two pictures.

5 Alter opacity
If you can’t see the second layer, tap and 
hold on the Opacity button in the bottom 
right-hand corner. Slide it up and down to get 
the perfect level of blend between the two 
images. Experiment to get it right.

9 Save down
Once you are happy with your blended image, 
tap the Share icon in the top right-hand corner 
of the app to save it to your library or Camera 
Roll. Alternatively, send to Photoshop or 
Lightroom for more advanced editing.

6 Cut out image
To ensure any part of the image you don’t 
want to appear on the blended image doesn’t 
come through, tap Cut Out at the bottom of 
the screen and rub your finger on the area you 
want to keep.

Don’t limit yourself to just two images. You are able to layer more than two 
images together so you can get really creative with all your photos. 
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News

Set up a News feed
made just for you

When Apple’s News app dropped with the iOS 9.1 update, it 
brought the world of personalised news updates to Apple users 
without the need to download a third-party app. News is a neatly 
packaged app that gathers stories based on your favourite 
publications and subject areas. It manages to achieve this by 
getting you to select which of the app’s selected news outlets, 
such as BuzzFeed or The Guardian, you would like to see news 
from and what kind of stories you are interested in, such as 
technology, sport and video games. This tutorial will show you 
how to put together the perfect set of news outlets and subjects 
so you can get your tailored news in a neat and efficient way. 

Use Apple’s News app to only access the news 
stories that you are interested in

Difficulty 

Download available

Time needed

1 Get started
You need the News app on your phone. If 
you haven’t got it, follow the steps in the 
Knowledge Base. Open the app and tap on 
Get Started to begin building your News feed.

2 Choose favourite outlets
You will see a long list of news outlets, ranging 
from broadsheet newspapers to entertainment 
websites. Tap on each one you want to see 
news from. You can tap as many as you like.

3 Sign up 
Once you have selected all the outlets you 
want to follow, tap Done. The app will ask you 
if you want big news items delivered to your 
email. Tap Sign Me Up or Not Now.

Personalise your News feedStep-by-step

10

Set up a News feed
made just for you
Use Apple’s News app to only access the news 
stories that you are interested in
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News reel

4 Get the news 
The News app is now operational. Scroll 
down the page to see the current stories. It is 
constantly updating so don’t forget to scroll up 
and refresh the page for more news.

5 Edit favourite outlets
Tap on the Favourites icon at the bottom of 
the screen to see all the outlets you have 
favourited. If you no longer want news from 
one, tap Edit and then the X in the corner. 

6 Add new interests
Tap the Explore icon at the bottom of the 
screen to add new publications to follow as 
well as confirm interest areas so you can see 
targeted news from non-selected outlets.

How Apple News presents 
your headlines

 See the headlines
The news is very simply laid out in a straight 
column, sorted by the time that the article 
was uploaded to the web. This makes it easy 
to scroll through.

 Search for stories 
If you are looking for a particular article or 
topic, tap on Search to type in a keyword. 
The app will search for relevant stories.

 Regular updates
The app will regularly be searching for new 
stories throughout the day. Look at the top 
of the screen to see if there is anything new 
since your last visit.

 Save stories
If you can’t read an entire article, at the 
bottom of the screen is the option to save it 
for later. Saved stories can be found behind 
the icon in the bottom right-hand corner.

 Knowledge base
Get News in the UK
If you live in the UK you 
might not be able to see the 
News icon. The easiest way 
to change this is to change 
your Region settings to USA. 
This can be found in the 
Language & Region section 
of your General Settings 
menu. You can always 
change it back again after 
you get the app.

In the Saved tab is your recently read history, so tap on that to show a friend a 
good article or quickly locate something you’ve already read.



Discover your iOS 
Accessibility settings

iPhones don’t offer a huge amount of customisation, so it’s up to 
you to get the most from the alterations you can make. Some of 
these can be found in the Accessibility section of your General 
Settings menu and open up a range of options for you to alter 
everything from the size of the text to your 3D Touch settings. It 
is primarily designed to help those with sight or hearing problems 
but there are benefits for everyone hidden in this menu.

This tutorial will go deep into the heart of your iPhone and 
explain all the little tricks and edits you can make to the settings 
so your device can be set up just how you want it to be. This 
might be the decision to squeeze out extra battery life by turning 
the screen black and white, to ensuring that subtitles appear 
automatically. Maybe you want a voiceover option to read out text 
– it can all be achieved via Accessibility.

We reveal the very best ways to embark on 
personalising your iPhone

Alter your Accessibility settingsStep-by-step

Difficulty 

Download available

Time needed

20

1 Enter the menu
Tap on the Settings icon on 
your iPhone’s home page. Scroll 
down to General and tap that. 
Midway down the page will be the 
Accessibility sub-menu option. Hit 
that to enter.

2 View the options
You will now see a long list of 
varied ways to alter aspects of 
your phone. Sliders are next to 
the ones with only two options, 
while there are arrows for actions 
that have multiple options.

3 Save battery
Beautiful as it looks, powering 
that gorgeously colourful screen 
drains a lot of your phone’s 
battery. Tapping on the Greyscale 
slider will turn everything black, 
white and grey.

“It is primarily 
designed to help 
those with sight or 
hearing problems 
but there are 
benefits for everyone”

Settings
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7 Highlight buttons 
Apple’s clean design is a major 
selling point but it can be a little 
tricky to see where the Back or 
Done buttons are. Tapping Button 
Shapes highlights any on-screen 
buttons for easier visibility.

8 Customise 3D Touch
3D Touch is a wonderful creation 
but even it could benefit from 
some customisation. In the 3D 
Touch sub-menu you can alter 
how sensitive it is and if it’s even 
on at all.

9 Set up shortcuts 
You may want to get things done 
without searching through menus. 
Scroll to the bottom to find 
Accessibility Shortcut and set up 
an action to occur after a Home 
button triple-click.

4 Speak-a-phone 
The VoiceOver menu contains a 
range of options for people who 
may struggle to read words on 
the page. Tap the slider and your 
iPhone will read out words on the 
screen that you have tapped.

5 Dark theme 
Android users have been crying 
out for a dark theme on stock 
Android and they still haven’t got 
it. iPhone users, however, can 
make their phones night-time 
friendly by hitting Invert Colours.

6 Enlarge text
In the Larger Text sub-menu, 
you can drag the slider across to 
make all words larger or smaller. 
Tap the Larger Accessibility Sizes 
slider to make an even larger font 
size available.

It can be a pain to activate 
subtitles, but this setting means 
all videos that have subtitles will 
play them automatically.

Automatic 
subtitling

The majority of features in the Accessibility menu are inactive until you activate 
them, apart from Reachability mode and Noise Cancellation.

1 Subtitles & Captioning
At the bottom of the Accessibility 
menu is the Media group. Tap on 
the Subtitles & Captioning sub-
menu and, once you’re in, tap the 
Closed Captions + SDH slider.

2 Choose your style
Tap on Style to select one of three 
preset subtitle styles. If none of 
them suit you, hit Create New Style 
and choose your font, size, text 
colour and background colour.
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Watch Vines on 
your Apple Watch

It might seem as though the Apple Watch screen is too small 
to properly enjoy videos but Vine clearly disagrees, because 
the video-sharing app is now compatible with watchOS 2. The 
videos have had to be shrunk and optimised for the square 
Watch screen but the ability to view those six-second snapshots 
on your wrist is yet another really exciting development for the 
smartwatch and its attempt to prove itself as a product that 
is worth getting. As with all Apple Watch apps you’ll have to 
download and set up Vine on your iPhone first before the icon will 
appear on your Apple Watch, but then you can begin enjoying all 
the weird and wonderful videos the internet has to offer. 

Turn your Apple Watch into a Vine-playing 
entertainment centre

Difficulty 

Download available

Time needed

1 Download Vine
Get the latest version of Vine on your iPhone 
by visiting the App Store and searching for 
Vine. Click Get. You need at least iOS 8.0 for it 
to work, so update your phone if necessary.

2 Put it on the Watch
Locate the Apple Watch icon on your iPhone’s 
home screen and tap on it. This will display 
the settings and apps available for the device. 
Scroll down to the Vine menu.

3 Add to menu
Tap on the Vine menu – you will see a slider 
that is currently black. Tap on it to turn it green 
and add the Vine app to the Apple Watch 
home screen.

Access Vine from your WatchStep-by-step

10

Vine
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Watching a Vine
Small videos on a small screen

4 Load Vine
Press the Digital Crown on the Apple Watch 
to see your list of apps appear. Use the 
touchscreen or Digital Crown again to tap on 
the Vine logo and enter the app. 

5 Find a Vine
You will probably have set people to follow 
and favourite subjects on Vine, so you should 
be able to scroll down through some Vines. If 
not, head into the iPhone app and do so.

6 Watch more Vines
Scroll to the bottom of the page where there 
will be two options. The first loads more Vines 
to scroll through, while the second reloads the 
front page in case new ones have appeared.

 Pause the Vine 
If you want to stop a Vine at a particular 
moment, tap on the screen and the video will 
stop playing. Tapping the screen again will 
start it playing once more.

 Video magic
The Vines have been optimised for the Apple 
Watch screen. While they obviously aren’t as 
sharp as on the iPhone, you still get a pretty 
decent picture quality.

 Stop the loop
The video will continue to loop until you stop 
it doing so. In order to stop it from playing, 
tap Done in the top left-hand corner of the 
screen and you’ll return to the list of Vines.

 Volume control
Once you’ve paused the video, tap on the 
volume slider and turn the sound up or down 
using the Digital Crown. Sound will happen 
even if your Apple Watch is on silent.

 Knowledge base
Prep your Vines
The app is limited to purely 
showing videos, which 
means there is no search 
function. All the preparation, 
such as choosing interest 
areas and people to follow, 
has to be done on the 
iPhone app. However, you 
are able to like and share 
videos that you’ve viewed on 
your Watch by tapping the 
heart or Share icon.

You can use the Digital Crown to scroll through the list of Vines or you can 
use the touchscreen to check out the videos. 

65



Chart your runs with 
Nike+ Running

Other than seeing your texts at a glance, one of the main benefits 
of the Apple Watch is as a fitness companion. Being able to 
see your speed, route and, of course, time without having to 
look at your phone or have an irritating voice cut through your 
music, spoiling your rhythm, is really useful. Apple’s Health app 
is excellent but if you are a dedicated runner it might be worth 
taking a look at Nike’s free Nike+ Running app. It provides a 
clear, concise breakdown of your running stats delivered straight 
to your Apple Watch as well as a map of your route and music 
information. This tutorial will show you how to set it up on your 
Apple Watch and what to expect from the training companion.

Keep track of your New Year’s fitness regime with 
your Apple Watch and Nike+ Running

Difficulty 

Download available

Time needed

1 Get Nike+ Running 
Head to the App Store and download Nike+ 
Running. Then, head to the Apple Watch app 
and scroll down until you find the Running 
app, which should be near the bottom.

2 Activate on your Watch
Tap on that menu and hit the slider next to 
Show App on Apple Watch so it turns green. 
It will then join the list of apps that appear on 
your Apple Watch’s home screen. 

3 Start your run
Load up the app on your iPhone, tap your 
name in the menu in the top left and then hit 
the Run option. Load up Nike+ Running on 
your Apple Watch and start running.

Use Nike+ Running with Apple WatchStep-by-step

10

Nike+ Running
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Track your progress
Measure your stats with the Apple Watch 

4 Track your run
The Watch will display the key information 
about your run in real time. This will be in the 
form of the distance you have run and how 
long you have been running for. 

5 Play music
Play music on your phone. Then, when the 
app is activated on your Watch, swipe to 
the left to pause, skip and rewind the songs 
without having to fumble for your mobile.

6 Final stats
Tap your Watch once you’ve finished and it 
will flash up your final statistics, including your 
average speed so you can check if you’ve 
achieved your aims at a glance.

 Average line 
To give yourself an idea of how well you’re 
doing compared to normal, the app provides 
a dotted line showing you the average 
distance of your last ten runs combined. 

 Swiping right
By swiping the screen to the right you can 
see how your run compares to your friends, 
as long as they also have the Nike+ Running 
app activated.

 Go the distance
At the end of your run, the Apple Watch will 
bring up a big, clear total distance, so you 
know how far you’ve gone without getting 
your sweaty hands over your iPhone.

 Recent history
Every run you track on your Apple Watch will 
appear in a graph on your Apple Watch so, 
hopefully, you can see how your distance has 
improved over time.

 Knowledge base
Map your run
As long as you have a view 
of the sky and a good GPS 
signal, your Watch will 
display and regularly update 
a map of the surrounding 
area and your route so far. 
You should therefore have a 
decent idea of where you’ve 
run, how far you have run 
and how to get back to your 
starting point again.

You can gain further motivation to achieve bigger things by the trophies 
Nike+ Running hands out, virtually of course, for reaching certain targets. 
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Set parental restrictions on Apple TV 
Keep explicit content and IAPs locked away safely

The Apple TV is a wonderful product to use. The intuitive touchpad 
on the remote makes life so easy for users; anyone can grab it and 
download games, movies and TV programmes. This, however, is 
where danger lies. With it being so easy to buy apps and pay for 
IAPs within games, bills can quickly rack up, especially if children 
have their finger on the button. Fortunately, Apple has made it easy 
for users to set parental controls on their Apple TVs as well as 
limiting the ability to pay for IAPs, so even when they’re away, their 
kids can’t rack up huge bills while playing Rayman Adventures. We 
will show you how to set up these parental controls for that added 
peace of mind when letting kids loose on the Apple TV.

Difficulty 

Download available

Time needed

10

Restrictions settings
What else can you change on your Apple TV?

 Age ratings
Movies and TV shows can be filtered 
out of view in the App Store to keep 
your kids away from inappropriate 
video content. 

 App restrictions
Even standard apps can contain 
material that isn’t appropriate for 
children. Tap on Apps to filter out 
ones rated as unsuitable for 4+ all the 
way up to 17+. Alternatively you can 
remove all apps entirely. 

 Music settings
As you can get iTunes on the 
Apple TV, there might be content 
unsuitable for children. Music and 
Podcasts can be altered to Safe 
from the default Explicit.

 Knowledge base
You still need to be 
on your guard…
Even when you’ve set 
restrictions on your Apple 
TV, keep an eye out for TV 
programmes and films that 
come via third-party apps, 
such as Netflix. Content with 
an age rating higher than the 
level you’ve set can slip past 
the filters so make sure you 
still keep tabs on what your 
kids are watching.

 Change Passcode
Tap on Change Passcode and, once you’ve 
inputted the current code, you can change 
it to something trickier to guess and keep 
those Restriction settings safe.
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1 Enter your settings
Use the Apple TV Remote to scroll to Settings. 
When highlighted, press down on the 
touchpad. The first sub-menu is General. It 
should be highlighted in white. 

2 Restrictions menu 
Tap on the General menu and scroll down until 
you reach Restrictions. It will be automatically 
set to Off. When it is highlighted white, press 
the touchpad to enter the menu.

3 Set a passcode
Once inside the Restrictions area, you will 
be prompted to set a passcode, preventing 
anyone from altering those settings without 
knowing the PIN.

4 Set restrictions 
Scroll down the list of options, pressing 
the touchpad to alter the settings for that 
particular app. Press it again if you want to 
return to the previous setting.

5 Stop location tracking
Right at the bottom of the Restrictions menu is 
the option to stop location services. You won’t 
be able to use features from certain apps, like 
Carrot Weather, but it will be more private. 

6 Specify your country 
In the Allowed Content list is the Ratings 
For sub-menu. As different countries have 
different ratings systems, you can ensure you 
get a country-appropriate age rating.

7 Block IAPs
In-app purchases can mount up so it is wise 
to block them from being bought. Tap to 
change In-App Purchases from Allow to Block 
so no one can accidentally buy extra lives.

8 Free apps only 
If you don’t want to pay for any kind of app, 
including renting movies, tap on Purchase and 
Rental to restrict that so you’re always assured 
of a cost-free Apple TV experience.

9 Exit Restrictions
Make sure you exit the app once you’ve 
finished, because otherwise someone could 
change the settings back. You’ll need your PIN 
to alter any of the restrictions from now on.

Activate Apple TV parental controlsStep-by-step

Unfortunately the restrictions aff ect everyone, unlike apps such as Netfl ix that 
have diff erent accounts for diff erent people so settings can be personalised.
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The ability to play games on your TV is just one of the Apple 
TV’s many exciting features. For a third of the price of a games 
console, you can play a wide range of titles. You can even play 
console favourites such as Rayman Adventures, showing that 
the Apple TV is a true multimedia device. As good as the Apple 
TV Remote is for playing games, when you’ve got complex 
games in front of you, you’ll want a proper controller to get the 
full experience. Bluetooth controllers for the Apple TV are an 
inexpensive way to get that experience and can be hooked up to 
your device in a matter of minutes so that you can begin to enjoy 
all the gaming joys the App Store has to offer. 

Difficulty 

Download available

Time needed

10

1 Enter your settings 
Use your Siri Remote to scroll to the Settings 
icon on your Apple TV’s home screen. When it 
appears larger than the icons around it, push 
down on the remote’s touchpad to enter.

2 Bluetooth settings 
Once you’re in your Settings menu, scroll 
down to Remotes and Devices. When you’re 
in that menu, scroll down until Bluetooth is 
highlighted and select that. 

3 Turn on Bluetooth 
Take your Bluetooth controller and turn it on. 
This will usually be a button or switch on the 
device. Next, push the button that activates 
the Bluetooth. The device should appear.

4 Connect controller 
Scroll down until the controller name is 
highlighted and tap the touchpad. The two 
devices should sync and pair. It will move to 
My Devices and say Connected.

5 Get games 
Head to the App Store and download games 
that require dexterity to play, such as racing 
games like Asphalt 8: Airborne. The controller 
will give you a greater degree of subtlety.

6 Play games 
Use the Bluetooth controller to navigate and 
select a particular game. You can switch freely 
between the two handheld devices to control 
your TV. Click on it and play the game. 

Connect a Bluetooth controllerStep-by-step

Set up a Bluetooth controller for  TV
Take your gaming to the next level with a compatible Bluetooth controller

tvOS
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Using a Bluetooth controller
How to reap the rewards of your gaming peripherals

 Easy connection
The Bluetooth connection is great 
because it means that you can use 
your controller with your Apple TV 
even if it isn’t connected to your Wi-Fi 
network. The Apple TV needs the 
internet but it’s functional even using 
an Ethernet connection.

 Subtle design
Usually the Bluetooth pairing 
buttons are hidden away at the 
top or bottom of the controller 
so it looks like a proper console 
gaming controller, complete with 
joysticks, control pad and R1, R2, 
L1 and L2 buttons.

 Console quality
Games such as Asphalt 8: 
Airborne and Rayman Adventures 
have shown that you don’t need 
to pay several hundred pounds 
for an Xbox or PlayStation to be 
able to play immersive, graphics-
rich games on your TV.

 Knowledge base
Multi-purpose
Don’t forget that you can 
use the Bluetooth controller 
for all your iDevice games 
so you can astonish your 
friends and online rivals with 
your immaculate iPhone 
control and button speed. 
The Bluetooth controller can 
also navigate around the 
Apple TV just as effectively 
as the remote.

 Getting ahead
The increased control you have over your 
game gives you that crucial edge, especially 
in racing games where precise movement 
and quick taps on the pad for braking are 
essential to securing victory. 

Many companies make Bluetooth controllers but not all are that good, so just 
be careful when buying one that is an unknown brand.

Your Apple TV Remote works just fine, so why would you 
want to get a second controller? To be honest, it’s probably 
only worth splashing out if you are either a committed 
gamer or a social gamer because on the whole, the Siri 
Remote gets the job done. Here are a couple of benefits to 
getting a Bluetooth controller for those of you who want to 
do more than play a simple puzzle game. 1 Multiplayer madness

The Bluetooth controller means that you can play 
multiplayer games with one on the Apple Remote, 
the other on the controller. This multiplayer aspect 
makes the Apple TV even more like a console as it 
encourages social gaming.

2 Greater controls
The Apple TV’s Siri Remote, with just half a dozen 
buttons and a trackpad, doesn’t have anywhere 
near the range of options that the controller has, 
so you can take your Apple TV gaming to the next 
level by connecting a Bluetooth device.

Why get a 
Bluetooth controller?

“This multiplayer aspect makes 
Apple TV more like a console as 
it encourages social gaming”
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Genius Bar
Our Apple devices and the software on them are some of the finest computing 
products on the planet, but even they have their moments. That’s where we 
come in; to give you expert advice and get you back up and running in no time

Apple’s Mail is marking good mail as junk mail. How can I stop it from 
doing this? David Morse

Contact us today
Glossary
The place to come for 
key technical terms made 
easy to understand 
Restrictions
Restrictions are an iOS 
feature better known as 
parental controls. They 
help to prevent access to 
certain apps, controls and 
features on iOS devices 
and stop any important 
settings being changed.

SSD/Solid State Drive
A newer type of hard drive 
that reads and writes data 
really quickly and has 
a lower failure rate than 
standard hard drives.

Secure Empty Trash
Guarantees your data has 
been destroyed by writing 
over it immediately after it 
has been deleted.

Split View
Enables you to run and 
display two apps side-by-
side on your iPad screen. 

AirPlay
Streams music, video, 
pictures and documents 
wirelessly to your TV or 
external monitor.

Font Book
Apple’s font management 
system where you can add 
and delete fonts.

Junk mail is managed 
at iCloud.com and not 

in the Mail app

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
icreatemagazine.com

Email
icreate@imagine-publishing.co.uk

1 Log in to Mail
Launch Safari or another browser 
and navigate to www.icloud.
com. Sign in to your iCloud 
account and click on the Mail 
icon in the top left-hand corner.

2 Find Junk folder
Click on the Junk folder in the 
left-hand column. Locate the 
mail that isn’t junk by scrolling 
through the folder or by using the 
Search box.

3 Mark as Not Junk
Above the email you’ll see a 
banner which says ‘iCloud thinks 
this message is junk’. Click on 
the Not Junk button to the right 
of the banner. 
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1 Select cells
Open your spreadsheet. Hold 
Cmd and select the number 
of cells equal to the number of 
columns to be inserted.

2 Insert columns
Right-click on the cells and 
from the drop-down menu 
select either Add Columns 
Before or Add Columns After.

3 Keyboard shortcut
Alternatively, hold down Alt and 
press the left or right keyboard 
arrow to insert columns to the 
left or right of the selected cells.

When I add a video to my Keynote it embeds 
it, making the file huge! How can I stop the 

video embedding? Sienna Davis
By default, Keynote automatically makes copies of 
any videos, audio or pictures that you add to your 
Keynote presentation. As you’ve rightly identified, 
copying a video into your presentation can make 
the file huge. You can stop Keynote embedding 
by selecting Keynote>Preferences>General and 
de-select ‘Copy audio and movies into document’. 
Now it will create a link to the media file, but the link 
will be lost if you move or rename the original file. 

I need to insert multiple columns into my Numbers spreadsheet. Can I 
insert multiple columns at the same time? Alan Hargreaves

How do I create a tri-fold brochure in Pages 5.6.1? I can’t find a template 
in the Template Chooser section. Tom Richmond

Junk mail for any provider that uses IMAP (syncs Mail changes between all 
devices) is always managed by logging into the website directly.

Slim down your Keynote by preventing 
video from embedding

 Make it your own
Re-arrange the template by selecting 
an object, such as a text box, and 
dragging it to another place on the 
template. Use any of the Insert icons to 
add new items to your template.

 Remove some items
If you want to keep key elements of the 
template, such as the background or image 
placeholders, remove everything else by 
holding down the Cmd key and selecting 
the objects that you want to delete.

 Find a tri-fold template
Select File>New Document, or click 
on the New Document button. In the 
Template Chooser section, select 
Miscellaneous. Open Museum Brochure 
or Elegant Brochure – both of these 
templates are tri-fold brochures.

 Empty the template
You can delete absolutely everything in 
the template by selecting the Edit menu 
and choosing Select All, or alternatively 
by holding down the Cmd and A keys 
on your keyboard. 

The one-stop 
column for 
Genius advice
Is it safe to delete font 
files after I’ve imported 
them into Font Book or 
do you need the original 
file for referencing?
Font Book copies each new 
font file into its directory 
when you import it. You 
may want to keep your own 
copy in case the font needs 
re-importing, but otherwise, 
you’re safe to delete the file. 

My Mac makes a sound 
that I’ve never heard 
before when performing 
an unrecognised action 
such as an incorrect 
keyboard shortcut.
You can customise 
the sounds that your 
Mac makes in System 
Preferences. Launch 
System Preferences and 
click on Sounds. Select 
Sound Effects and click on 
Funk to return your alert 
sound to the Mac default. 

I can’t find the Secure 
Empty Trash feature 
since upgrading to El 
Capitan. I’ve looked in 
Finder Preferences but 
it’s not there.
The Secure Empty Trash 
option was removed with 
the release of El Capitan. 
According to Apple, 
this was due to issues 
guaranteeing the secure 
deletion of files from Flash 
storage. If you’re concerned 
about the security of your 
files, you should consider 
using an encryption solution 
such as File Vault.

Apple 
Expert
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I can’t remember my 
Restrictions 

password for my iPhone. 
Can I reset it without 
needing to wipe my 
iPhone? Chris Carter
If you’ve forgotten your 
Restrictions passcode, 
you’ll need to connect your 
iPhone to a PC or Mac and 
restore it using iTunes. If 
you don’t have access to 
iTunes, you will need to 
remotely erase your iPhone 
from www.icloud.com. 
Once you’ve signed in, click 
on the Find My iPhone icon 
and choose your iPhone 
from the list of active 
devices. There, you can 
remotely erase your iPhone 
back to factory settings – 
don’t forget to back up first!

When I receive an 
iMessage with an image, 

a Tap to Download button is 
displayed instead of the image. 
Why is this happening?
Eleanor Sims
It sounds like the image is stuck 
on the iCloud server. It might 
sound dramatic but it’s easy 
enough to release it. Here’s how. 
Firstly close down the Messages 
app. Launch the Settings app, 
tap on Messages and select the 
Send and Receive option. Next, 
tap on your Apple ID and then 
tap on the Sign Out option. Be 
patient and wait a few moments 
for your Apple ID to fully finish 
signing out. Tap on Apple ID 
to sign back in again with your 
normal details. Allow a few 
minutes to sync and you’ll be 
able to view the image.

Set a memorable 
Restrictions passcode or risk 

erasing your iPhone

Every time I make a new playlist on my computer, then sync my iPhone 
to my computer, the playlists don’t appear on my iPhone. Julie Mears

 Connect your iPhone
Connect your iPhone to your PC 
or Mac and launch your iTunes 
app. Click on the iPhone icon in 
the top left-hand corner of the 
iTunes interface.

 Sync your playlists
Click on the Sync button to transfer 
the playlists to your iPhone – 
remember, you need to perform a 
sync each time a new playlist has 
been created.

 Turn iCloud Music 
Library off
Click on Music in the left-hand 
column. If ‘iCloud Music Library 
is switched on’ is displayed, 
turn this off by heading to 
Settings>Music on your iPhone.

 Enable full music sync
Check the Sync Music option if this 
isn’t already checked. Ensure that 
Entire Music Library is marked – if 
not, click on this to activate it.

Genius Bar

The one-stop 
column for 
Genius advice
My iPhone display has 
been randomly reacting 
to a ghost touch since I 
had it repaired. Can I fix 
this myself?
Take your iPhone back to 
the Apple Store where you 
had it repaired for further 
assessment – each repair 
comes with a 90-day 
warranty so you’ll be 
entitled to any necessary 
repairs for free if this is what 
is required.

Which cable do I need to 
connect my iMac to my 
2007 Mac Pro to be used 
as an external monitor? 
Only iMacs manufactured 
between late 2009 and mid 
2014 support being used 
as an external monitor. 
You’ll need a Thunderbolt 
port on your Mac Pro and a 
Thunderbolt to Thunderbolt 
cable to be able to connect 
them together.

I’ve got a Silica gel 
ball stuck in my Mac’s 
headphone jack. How 
can I remove it safely 
without causing any 
serious damage?
Silica gel balls are one 
pesky obstruction to 
remove! You should take 
your Mac to a trained 
Apple technician who can 
try to safely remove the 
obstruction. There is no 
guarantee, however – it 
depends on the location of 
the gel ball in relation to the 
delicate hardware inside the 
headphone jack.

Apple 
Expert
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To stream your iPad’s screen wirelessly to an external monitor or TV, 
you’ll need to connect an Apple TV to your external device to use AirPlay.

I can’t open an Excel document on my iPad using Numbers. 
How can I convert it so it can be opened? Simon Harris

Will an iPad Pro display a Keynote 
presentation in Split View mode 

when streaming to an external monitor via 
AirPlay? Stephen Cator
The iPad Pro is so new that even we weren’t 
sure of the answer to this question. We did 
some research with our iPad Pro, and can 
confirm that most of time the entire screen 
is simply mirrored. Don’t panic though, as 
if you are in Keynote Presentation Mode in 
Split View on your iPad, you can only see 
the Keynote on the external monitor and not 
the second app – so you can simultaneously 
present your Keynote to your audience, see 
the slides on your iPad and have your notes 
accessible only to you.

I can’t access the Cell menu in 
Numbers for my iPad. Has it been 

removed? Adrian Marks
For Numbers users, a double-tap is the way 
to access the Cell menu, which contains 
lots of extra formatting, input and function 
options for each cell in your Numbers 
spreadsheet. However, in a recent app 
update, the way to access this menu has 
been changed. Users now need to perform 
two discrete taps on the screen to bring up 
the Cell menu in Numbers. Don’t confuse 
this with a double-tap however – just lightly 
tap twice in quick succession on a cell to 
display the menu that you need.
 

 My Pages app is stuck during the update and I can’t delete it. 
How can I free up the download? Simone Birch

1 App storage
Launch Settings on your 
iPhone or iPad and navigate 
to the General menu. Scroll 
down and tap on Usage and 
then Manage Storage.

2 Find corrupt app
Next, look for the Pages 
app in the list, or if you can’t 
locate it, look for an app icon 
with no label. Tap the Delete 
App option.

3 Reset
Perform a hard reset of your 
iPhone by holding down the 
Power button and the Home 
button. Re-download Pages 
from the App Store.

Split View enables you 
to display two apps 
simultaneously on the screen

Lightly tap twice in 
quick succession to 

display the Cell menu

 1. Locate Excel file
On your Mac, open Finder and 
select iCloud Drive. Locate the Excel 
spreadsheet that you want to convert 
into the Numbers format.

 2. Open With to convert
Right-click on the Excel file and choose Open 
With from the drop-down menu. From the 
pop-out menu that appears, choose Numbers 
to convert into the Numbers format.

 3. Convert using the 
Numbers app
Alternatively, you can covert 
the file using the Numbers app. 
Launch the Numbers app and 
click on the File menu. Choose 
Open from the drop-down.

 4. Open File and 
Convert
In the Open window interface, 
click on iCloud Drive in the 
left-hand column and locate 
the Excel spreadsheet that you 
want to open in Numbers.
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5 Remove SSD screw
Using a T5 Torx screwdriver, remove the single 
screw on the left-hand side of the SSD attaching it 
to your Mac’s logic board.

6 Remove the SSD
From the SSD’s left-hand end, carefully lift the 
SSD upwards and gently pull it out of its socket 
attached to the Mac’s logic board.

3 Stop the power
Remove the warning notice plastic above the 
battery connector and use a nylon probe to lift the 
battery connector up and out of its socket.

4 Watch the battery
Bend the battery connector wires slightly, in the 
direction away from the SSD, to prevent accidental 
contact during the process of the SSD upgrade.

1 A screw loose!
Remove all screws from the bottom case. 
Remember that the middle two screws at the top 
of the case are slightly longer than the rest.

2 Remove the case
Slide two fingers underneath the centre of the top 
of the bottom case to provide space to lift and 
gently pull the bottom case away.

I’m running out of space on the hard drive of 
my MacBook Pro Retina. Can I upgrade the 

SSD for one of a bigger size? Luke Branch
Although it is commonly thought that you cannot upgrade the SSD 
in the MacBook Pro Retina models, the reality is that you can – you 
just need to ensure that you purchase the correct SSD. SSDs inside a 
MacBook Pro Retina look like a stick of RAM and the sizes vary between 
models, so it’s important that you purchase the correct SSD otherwise 
it won’t fit! A big benefit of the MacBook Pro Retina is that internally it’s 
minimalistic, so carrying out an SSD upgrade is really simple. Before you 
get started, don’t forget to create an El Capitan Boot Drive so you can 
re-install Mac OS X El Capitan on your new SSD.

The one-stop 
column for  
Genius advice
I’ve purchased new RAM 
for my 2012 Mac. Can I 
install the old RAM into 
my 2009 Mac to boost it?
Although RAM modules 
look the same, they have 
different speeds that are 
compatible with specific 
Mac models. RAM from 
a 2012 model won’t be 
compatible with a 2009 
model, however RAM is 
pretty cheap to purchase.

How do I restore pre-
installed iWork and 
iLife apps to my 2010 
MacBook Air? I can’t 
find the original software 
install disk.
Your Mac should have 
appropriated your iLife and 
iWork to versions in the App 
Store when Apple stopped 
selling physical copies 
of the software – find 
iWork and iLife under the 
Purchases tab in order to 
download them.
 
I’ve just purchased a 
new Mac. How can I 
transfer my files from an 
old Mac to my new one?
Connect an Ethernet cable 
between your old Mac and 
your new Mac (you’ll need 
to use an Ethernet adaptor 
if you have a MacBook 
Air, MacBook Pro Retina 
or the new MacBook). 
Launch your Applications 
folder and open Migration 
Assistant from the Utilities 
folder. Follow the on-screen 
instructions to transfer all of 
your information.

Apple 
Expert

Genius Bar
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You’re right not to throw your MacBook Pro into the trash and buy a new one just because it displays the 
smallest hint of old age. A new Mac is an expensive solution, while small upgrades are not. Compared to 
the newer models of Apple’s notebook, which have limited hardware upgrade options, there is a whole heap 
of things that you can do to improve the life of your current 2010 MacBook Pro. You’ll be surprised at how 
much longer your Mac will last with a few changes, all of which are low-cost and easy to implement. Let’s 
take a look at some of the components you can upgrade or replace to give your loyal MacBook Pro an 
entirely new lease of life. Each of these upgrades can be completed by you, with little or minimal fuss and 
expertise required. It’s a win-win!

Tools needed
Missing any of these? 
You can order any 
parts or tools you 
might need from www.
ifixit.com/store.
• Phillips 000 
crosshead screwdriver 
• Phillips 00 crosshead 
screwdriver
• Torx T6 screwdriver
• Torx T8 screwdriver
• Y1 Tri-Wing 
screwdriver
• Nylon probe

If you would like more help with upgrading your Mac, visit the 
gadget surgeons at iFixit.com, who kindly contributed these photos.

My 2010 MacBook Pro is looking a bit tired. What can I upgrade to keep it 
going while I save up for a new one? Emma Hatton

Buying the right SSD for your Mac is tricky, especially as SSDs for Mac are still 
not widely available. Head to www.crucial.com to get yours.

 Optical drive
Let’s be honest: who really uses their CD 
drive anymore? Remove the optical drive 
and install an ‘opti-bay’ which stores an 
SSD. You can use your existing hard drive 
for back-up file storage.

 RAM
As applications become more powerful, 
they require more RAM to run. If you’re 
running powerful applications on your Mac, 
you may find that upgrading the RAM will 
give your Mac a new lease of life.

 Battery
Batteries have a shelf life of a 
couple of years, depending on how 
often you’re charging your Mac. 
A replacement battery is around 
£100, easy to fit and will enable you 
to leave your charger at home!

 SSD
Installing an SSD into your Mac will 
decrease its boot time massively and also 
speed up the responsiveness of your Mac, 
as it reads and writes files much faster than 
a standard hard drive.

 Hard drive
By upgrading your hard drive to one with 
more storage capacity and a higher read-
write speed, your Mac will instantly speed 
up as it can read files more quickly and 
provide more storage space.
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Group test

Design
Sadly, design is seriously lacking in the M535. 
It rather looks like a product designed in the 

90s and has absolutely nothing to get excited 
about. It is nice and thin, however.

Design
Not a lot of work seems to have gone into 
the design of the S Action mouse. It sports 

a plain, black finish, two buttons and a scroll 
wheel but certainly doesn’t stand out.

Comfort
The mouse is made of a cheap-feeling, 

scratchy plastic that isn’t great to hold. It also 
doesn’t hug your palm all the way round, 
leaving your hand hovering awkwardly. 

Comfort
The smooth plastic does feel nice and it fits 
neatly into the crook of your hand, but might 
be a little on the small side for a lot of people.

It scores well for portability, though. 

Value for money
It is about the same price as its competitors 

and doesn’t offer any extra features to 
make you choose it over them, so the M535 

represents poor value for money here. 

Value for money
It’s not very pricey but doesn’t need to be. 

You are paying a small premium for the name 
but you aren’t exactly getting ripped off or 

getting a bargain.

Key features
The M535 really doesn’t have any standout 

features to it, barring the Bluetooth 
connectivity which, to be fair, does work 

faultlessly and without lag.

Key features
The Bluetooth connectivity is a pretty major 

feature and it connects very quickly but does 
have a few jerky moments, which is a flaw that 

can easily get frustrating. 

It works but that’s about all the praise this mouse 
will get. The design is tired, there’s nothing 
exciting about it and there are much better 

options out there. 

The S Action mouse is a solid enough product 
and looks okay, but the Bluetooth connection 

isn’t immaculate and there isn’t much 
groundbreaking going on here.

VerdictVerdict

Logitech M535
£34.99/$39.99

 logitech.com

Samsung S Action mouse
£39.99/$39.99

samsung.com

The computer mouse hasn’t evolved an 
awful lot since it was first invented in 1964 
by Douglas C Engelbart and refined by Steve 
Jobs in 1984. Whether one button or two, 
the mouse has remained largely untouched. 
The simple curved mouse guided by lasers 
dominates the market because it is a classic, 
comfortable design that people are familiar 
with, much like gaming controllers that 
generally follow a fairly standard pattern. 
However, there are some alternatives that 
are beginning to make waves these days as 
people are using their Macs to play games, 
design apps and create art, so we thought 
we’d put them to the test and see what should 
be your next mouse. Each has its own, unique 
style, selling point and amount of time required 
to get used to – Penclic, we’re looking at you 
– so make sure you know what you mainly use 
your Mac for when deciding. 

We used each mouse exactly as we would 
during a normal day. Each one was put through 

its paces by navigating the web, working its 
way around Word, email, selecting songs via 
iTunes, downloading content, putting up a 

WordPress post and all the other day-to-day 
activities you’re likely to do during your average 

day and night on your Mac.

How we did the test

Third-party 
mice tested
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Design
It’s a bit bizarre, having a pen mounted on 

a stand, but it looks pretty cool. It is a bit of 
a shame that you can see the internals but 

overall it’s well designed.

Comfort
Once you get to grips with the Penclic, it’s 
very comfortable to use. It would be nice if 
it was easier to not accidentally click both 

buttons but you eventually get the hang of it. 

Value for money
Clearly a lot of work has gone into making the 

Penclic a top quality, ergonomically-sound 
piece of kit, but it still feels as though it is a lot 

of cash for what it is. 

Key features
The Penclic is designed to be an ergonomic 
marvel, keeping your hand in a more natural 
position. In this regard it is excellent and you 

notice the difference quickly.

It looks bizarre and takes some getting used 
to, but if you use your computer a lot this might 
just save you from RSI, although there are less 

extreme options available.

Verdict

Penclic R3
£59.99/$89.95

posturite.co.uk

Design
This is simply one of the coolest computer 

accessories you’re ever likely to see. A vibrant 
red main body is flanked by two black edges 
and a prominent black and red scroll wheel. 

Comfort
It is simply a delight to hold. The indent on the 
left houses your thumb comfortably and the 

ridge on the left cradles your index finger. It is 
soft, smooth and well-sized. 

Value for money
Although the US price is a lot higher than 

most of the other mice, it is still good value as 
it can do so many things, especially valuable 

to a hardcore gamer or heavy Mac user.

Key features
The Kudos Z-9 gives you more options than 
you possibly need, with the addition of nine 

programmable buttons that can change your 
Mac’s volume, among other things.

This mouse looks incredibly cool, is intelligently 
designed, feels great and can do more than all 
the others with its programmable buttons. It’s 
pretty much everything you want in a mouse.

Verdict

Kudos Z-9 gaming mouse
£39.05/$64.99

speedlink.com

Design
On the surface, the Rival 100 is fairly standard; 
black and sleek with the SteelSeries logo on 
the base. However, when plugged in it glows 

red, which is awesome. 

Comfort
The Rival 100 is really nice to hold, with an 
elegant curve down the fingers and a tight 
drop so your wrist can rest comfortably on 

your desk.

Value for money
This is a bargain. The mouse is excellent 

quality and is one of the cheapest options 
in this group test. You’re getting high level 

responsiveness for a very reasonable price.

Key features
The responsiveness of the Rival 100 is 

something SteelSeries prides itself on and it 
really is lightning fast and moves exactly how it 

should. Precision gamers, take note.

This is a great plug-in-and-go mouse that is 
superbly responsive to both movements and 
clicks, so if you want to gain those extra split 

seconds, Rival 100 is well worth a try.

Verdict

Rival 100
£30 (€39.99)/$39.99

steelseries.com
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Reviews

The market for high-end speakers is 
fierce, so it’s imperative that any new 
entry stands out from the crowd. One of 
the first things that helps this offering 

from B&O Play is just how stunning it is. 
The thin, elongated shape fits in well to most 

neutral décors, and the extended mesh front 
helps fill any room with sound. There’s little in 
extra aesthetic features, but the minimal design is 
certainly to our tastes.

Users have a myriad of streaming options at 
their disposal through the A6, with Bluetooth, 
DLNA, AirPlay and NFC all possible options. 
Both connecting and initial streaming is easy to 
complete and the added support for the likes of 
Spotify Connect is a nice touch. 

No matter how you want to enjoy your music, 
the A6 certainly has you covered. Built into the A6 
is a five-channel speaker that offers pitch-perfect 
sound no matter where it’s placed in the room (the 

handle makes it easy to transport too), but also has 
enough power and delicacy to cater for the most 
bass-heavy or acoustic-based tracks. 

The lack of clear playback controls at first 
glance left us scratching our heads, but the A6 
uses a gesture system that’s both useful and 
intuitive. Swiping left and right on the top of the 
speaker increases volume, a quick tap will pause 
the song, while a longer hold will skip the track 
altogether. Of course, users can still call upon their 
iPhone to control playback, but the gestures are 
certainly a nice extra.

At £799/$999, the BeoPlay A6 is a costly 
investment, but it’s one that will last you a long, 
long time. Not only does it look great, but it has 
enough subtle inclusions built within to help it cope 
with any and all music you throw at it. If you’re on 
the hunt for a new high-end speaker, the A6 may 
be what you need. Just make sure no one sees 
your bank statement.

Key features
Dual 5.5-inch woofers • Two 3/4 tweeters • AirPlay support

Learn more
www.beoplay.com

Available from
www.beoplay.com

If you’ve got the budget and the room for it in your home, the BeoPlay A6 is easily one of the 
premier home speakers out there. A must-have for any audiophile.

BeoPlay A6
£799/$999

Verdict

The built-in 38mm driver is the main 
reason why the A6 is capable of filling 
any room with music

By either swiping, tapping or holding 
the top of the A6, users can play with a 
variety of gesture-based controls

The gorgeous wool mesh is great at 
providing full audio transparency for 
acoustic-based tracks
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Key features
Rec.709 colour reproduction • 100ft wireless coverage • Zero latency

Learn more
www.benq.co.uk

Available from
www.benq.co.uk

BenQ has a glowing reputation in the world of 
projectors, with the W2000 its latest entry in a bid 
to take over your living room. For the most part, 
it looks largely the same as many of its previous 
models, apart from the slightly cheesy champagne 
gold finish on the front and the expanded selection 
of playback controls on the top. 

We were happy to see the ridiculous amount of 
ports on offer on the rear of the unit, and these 
options compare well to some of the leading 
projectors on the market. In addition to the standard 
dual HDMI ports, there’s also a RS-232 port, 12V 
trigger output and a 3.5mm audio loop through to 
name just a few. It’ll be daunting for those new to 
the world of home projection, but enthusiasts will 
feel at home here.

While set up can be a little tricky at times, partially 
due to the sheer amount of calibration options 
littered throughout, picture quality when in use is 
fantastic. The colour palette is well balanced and 
there’s no stuttering during high-paced motion 

sequences – a common issue we’ve discovered that 
plagues many mid-range projectors. Grainy images 
can tend to be a little washed out in their darkest 
areas, but it’s barely an issue worth fretting over. 
Plus, the added playback controls are particularly 
useful if you want to make minor edits to the 
projected image.

What surprised us more than anything else was 
the sound quality of the projector – it’s up there with 
the best on the market. We wouldn’t say that you’ll 
be replacing it with your main speaker in your AV 
setup, but it’s decent enough to cope with most 
movie soundtracks.

BenQ’s emergence in the field of projectors is 
getting stronger with every new unit it releases. In 
many ways, the W2000 is the best effort yet, but 
it’ll be a little too complex for those looking for an 
introduction into home projection. Those that fall 
under that category would be better looking through 
BenQ’s vast portfolio of projectors. You’re bound to 
find something to suit.

While not tailored for those who are looking for their first-ever home projector, the W2000 offers one of the most 
complete projector packages we’ve seen. One for the seasoned AV enthusiasts.

BenQ W2000
£799/$TBA

Verdict

The front lens can be adjusted to 
project images from as little as 2.5 
metres at a giant 100-inch sizing

The rear of the unit reveals a myriad of 
connection ports. Novice users should 
stick to the HDMI offerings

Use the on-board playback controls to 
change both audio and video settings 
in a flash



82

Key features
FullRoom SoundSpace • Wool sleeve • Carry handle

Learn more
libratone.com

Available from
libratone.com

Reviews

If you’re looking for well-built, portable speakers for 
most scenarios, then the Libratone ZIPP is surely 
one of the best tools for the job.

Sold in one of four different colour covers, made 
from fine Tuscan wool, the ZIPP can complement 
most home setups. The CoolWeave mesh works 
wonders, enabling the sound to penetrate through 
each of its 20 wool layers. The strap is attached 
securely at the top and lets you hang the device 
on a hook or just carry it around – although we 
found using the strap cumbersome as it meant the 
speakers were dragged up on only one side.

While the ZIPP itself is not intuitive on first use, 
the accompanying Libratone app is easier to control 
thanks to a clearer layout. The app is essential and 
it can do almost everything that the speakers can 
do (bar physically turning it off), providing a fun, 
sharable and wireless music experience.

To ensure an even distribution of high-quality 
sounds, the ZIPP boasts the use of its 360° 

FullRoom SoundSpace technology and AirPlay. 
FullRoom SoundSpace keeps the ZIPP loud and 
clear no matter where you are standing and the 
size of the space you are in. With AirPlay, the 
device utilises the audio streaming technology to 
ensure that music doesn’t get compressed over the 
wireless network – as it can do over Bluetooth. 

It’s the combination of the two that makes the 
music both clear and boisterous, shown best in 
Sting’s Englishman in New York where every single 
orchestral instrument was well defined. The mids, 
however, are generally a bit lacking, compensated 
gratuitously by the bass, which becomes a bit more 
obvious when streaming Windowlicker by Aphex 
Twin. Generally, the inequality is not that noticeable 
and the overall sound is still dynamic even with more 
vocal-focused tracks like Tracy Chapman’s Fast Car. 
Frankly, we’re impressed with the ZIPP’s finesse for 
sound, design, and software and hardware build for 
such a low price.

It’s a great addition to any home, and wonderful for outdoor events if you combine with its sister products for a 
seamless experience – but we just wish we could change the EQ settings.

Libratone ZIPP
£219/$299

Verdict

Humanely sheared wool is layered 20 
times and then mechanically bonded 
to create the thick, mesh fabric 

Change the volume by swiping on 
the dial, and hush the speakers by 
hovering your hand over it

The ZIPP has about eight hours of 
battery once unplugged but will turn 
off to conserve charge
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Key features
iPad docking bay • Two-deck mixing • 16 RGB pads

Learn more
www.reloop.com

Available from
www.reloop.com

Is there anything the iPad can’t do? While Apple’s 
tablet has already proven itself to be rather versatile, 
we honestly never expected we’d be able to sit 
down and kick out quality beats with it anytime 
soon. But here we are with an iPad mini sat snugly 
in the docking bay of Reloop’s BeatPad 2, doing our 
best to slice together our favourite Spotify playlists 
into the next summer sensation. 

Okay, so in reality we are making such an 
unnecessary amount of noise that we aren’t sure 
our neighbours will ever forgive our delirious 
scratching all through the night. But that’s on us; we 
didn’t make use of the two headphone connections 
on the front side. 

Reloop’s BeatPad 2 isn’t designed for amateurs 
– it’s a robust and solid piece of kit for budding 
enthusiasts looking for a new way to experiment 
with their favourite tracks and beats. And that’s 
okay; the entire package might be incredibly 
intuitive, but using it isn’t going to turn you into the 
next Terminator X overnight. 

The djay 2 app for iOS devices is a good place 
to start trying, though. It wastes no time instantly 
recognising your device’s music library and/or your 
Spotify Premium account, and you won’t likely be 
disappointed by the two-deck mixing that it offers. 
If you’ve spent any time noodling with desktop 
DJ software in the past, you’ll feel right at home 
here; though don’t expect it to hold your hand, 
you’ll be thrown right into the deep end in terms of 
functionality and execution. 

Still, apps update and the BeatPad 2 will not. 
Thankfully, what Reloop has delivered here – across 
the 16 RGB pads and eight performance pads – is 
incredibly intuitive. Everything, from creating Bounce 
Loops to quickly Slicing tracks on the fly, works 
exactly as you’d expect it to. 

Okay, so it’s an expensive piece of technology, but 
you’ll certainly get your money’s worth. This might 
just be the first viable alternative to hauling vinyl 
decks or a laptop around to create professional-
grade mixes.

A well-designed and intuitive piece of kit that should give any DJ enthusiast 
a new way to experiment and mix tracks professionally on the move. 

Reloop BeatPad 2
£349.99/$599.99

Verdict

Mix beats with any device thanks to 
the XLR and RCA outputs and the aux 
input for iPod, CD player or turntables

These touch-sensitive drum pads let 
you take full control of Slicer, loop, 
sampler and dynamic multi-effects

While the non-adjustable cradle will 
fit other mobile devices, it has been 
designed with iPad in mind
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Key features
10-degree slant • Walnut vinyl finish • Bluetooth 4.0

Learn more
www.edifier.com

Available from
www.edifier.com

Reviews

It’s a sensible stance to always be on the wary 
side of budget Bluetooth speakers; manufacturers 
are often forced to make some pretty savage 
compromises in order to keep the price at an 
attractive level. But the R1700BT from Edifier makes 
a few clever design choices to ensure that – while 
not perfect – you shouldn’t be too disappointed with 
your investment. 

Built on a 10-degree slant, equipped with a lovely 
walnut vinyl and black body finish, and on-board 
rotary controls for bass, treble and volume, 
everything certainly comes together to make the 
R1700BT aesthetically pleasing. But does it have 
the charm where it counts – the sonics? This is a 
Bluetooth speaker with some serious chops; the 
active and passive speakers combining nicely to 
create a lovely and warm mid-range across a wide 
variety of music. 

Edifier has imbued this device with an enthusiastic 
tone that doesn’t suffer on low-resolution streams, 
such as Spotify and SoundCloud, and that means 

it handles competently across almost any type of 
music you want to pump through it. Vocals are 
delivered smoothly, floating nicely over the warm 
mids; treble can have a tendency to sound a little 
thin on guitar-heavy music, though it never threatens 
to become sharp; the dynamics are punchy and 
well-defined, which ensures emphasis is put in all 
the right places. 

Where Edifier stumbles is with its handling of 
the low-end. Bass over-delivers, it just doesn’t gel 
well with the overall sound mix at all. This will be 
especially evident on albums that suffer from poor 
production or mixing – see basically any niche rock/
metal/hip-hop album from the 80s – and no amount 
of knob twiddling seems to rectify this. 

But for those of you who like your bass loud, 
proud and booming beyond belief, we imagine 
this is a situation you could learn to live with. For 
the price, the R1700BT is an incredibly attractive 
proposition – you’d be hard pressed to find such 
quality in this bracket.

You won’t likely find better speakers for the price, but that doesn’t mean they are perfect. 
We have issues with the heavy bass but if you can overlook that, you’re in for a good time. 

Edifier R1700BT
£119.99/$149.99

Verdict

The R1700BT comes equipped with 
Bluetooth 4.0 for top quality listening 
from almost any modern device

These speakers are built with a 
10-degree angle; the lift from the 
surface increases audio quality 

The 4-inch subwoofer hits up to 6 ohm 
and you can really hear that on the 
overpowering bass
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Twelve South BaseLift
£32.64/$39.99

www.twelvesouth.com
The BaseLift raises the rear of your MacBook to help give 
a better typing experience and prevent RSI from rearing its 
ugly head. The adhesive lining sticks to the bottom of your 

computer with ease, but getting it lined up straight is crucial 
to avoid a misaligned rear lift. While different raised levels are 
achievable, folding them in place can be a little fiddly at times, 

but they do remain firm once you’ve found the level that’s 
perfect for you. When not in use, the BaseLift is removable 
and we were happy to see that no residue was left behind 

once we had removed the adhesive backing.

Devolo dLAN 650+
£99.99/$TBC

www.devolo.com
Wi-Fi extenders tend to be hit and miss, and while 

we were sceptical about the lack of wires with 
Devolo’s 650+ starter kit, we were pleasantly 

surprised with the end results. With one of the 
adapters being plugged into your mains and router, the 

second adapter can be placed in any other mains outlet to 
extend your connection. The setup takes moments and 
internet speeds remain stable, with the accompanying 

software crafted to make it simple to see how your connection 
is spread. Multiple devices can be added, but you’ll need to 

invest in further adapters if you want more coverage.

Accessories
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Libratone ZIPP MINI
£179/$249

www.libratone.com/uk
While noticeably smaller than Libratone’s original ZIPP 

speaker, it carries on with the fantastic design and sound 
that made us fall in love with the original. There’s great 
depth to the bass and clarity is comparable to similarly 
priced offerings on the market. The connection options 
are plentiful and generally work well, with AirPlay being 

particularly easy to set up and use – and should really be 
the primary choice for all iOS users. Despite this being the 
MINI version, it still isn’t as portable as we’d like and the 
lack of water-resistance means that it isn’t suited for your 

camping trips and festival visits.

iKlips (32GB)
£69.99/$79

www.adamelements.com
If internal storage is a constant problem for you, then a 
flash storage drive may be your best bet for a quick fix. 

The iKlips is one of the more intuitive ones on the market, 
connecting via the Lightning port and providing an easy 

solution for moving files to and from your iPhone. Transfer 
speeds are quick through the accompanying app, but the 
app stability is questionable – with crashes commonplace. 
There’s also a USB connector included for Mac transfers 
and a clip for keeping the drive on your person, but it’s a 

little flimsy for our liking. 

STK QTouch Wireless 
Charging Pad & Case 

£24.99/£49.99/$TBA
www.stk-acc.com

While requiring both elements of 
STK’s QTouch wireless charging 

system won’t be too pleasing on your 
wallet, both elements work really well. 
Wireless charging between case and 
pad are quicker than through a mains 
adapter and the lack of wires helps 
keep it clutter-free. The pad is small 
and sleek, with a microUSB port on 

hand when it needs a charge. To 
pack in the necessary Qi technology, 
the case is on the bulky side and it’s 
especially noticeable on the slender 
frame of the iPhone 6. That said, if 

you solely use the case for charging 
purposes, you won’t find a much 

better solution on the market.
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As the name would suggest, CleanMyDrive 2 is a 
disk clean-up app that was recently updated with a 
new interface and extra features. It sits in the menu 
bar at the top of the screen and when the icon is 
clicked, it displays a drop-down list of internal and 
external disk drives. These include hard disk drives, 
SSDs, and USB memory sticks.

You can instantly see the size and free space 
remaining on each one, and the amount of junk 
they contain. The usage bar for each drive is colour 
coded with sections that show the space used 
by photos, movies, audio and so on. More details 
appear when the mouse hovers over the sections.

The app provides users with a number of 
functions, the main one being to clean the disks 
by removing unnecessary files. The boot disk is an 
exception, but it cleans every other disk. Deleting 
files on external disks does not recover the space 
because they are simply hidden and the disk fills 

up. CleanMyDrive clears deleted files and other 
unnecessary content like hidden .ds_store files, 
Spotlight search data and so on.

Clicking a disk opens Finder and dragging files to 
a disk copies them to it. Hover over the drive and 
a Finder window opens to let you drop files into a 
folder. This means you can hide the drive icons on 
the desktop for a clutter-free view.

Disks can automatically be ejected when the 
Mac enters sleep mode and disks can be manually 
ejected by clicking the icon next to each one or the 
master eject-all icon at the top. A clean up can be 
automatically performed when a disk is ejected. This 
ensures that disks are automatically cleaned every 
time you put the Mac to sleep.

In-app purchases enable you to assign custom 
icons to the disks, but they are purely cosmetic. 
Scans for junk can slow old drives a little, but new 
Macs with SSDs are great. It is recommended.

CleanMyDrive is a useful utility for people with external drives and USB memory sticks. 
It cleans the junk and increases disk space.

CleanMyDrive 2
Free

Verdict

View disk usage
Mouse over the usage bar and up 
pops an information box showing 

what’s using the space.

Automatic options
Expand a disk for useful options 
like Automatic Cleanup whenever 

the disk is ejected.

Erase disks
Expand a disk and use Erase and 
Eject to wipe it. The dark interface 

is shown here.

3 Key Features

“The app has 
a number 

of functions, 
the main 
one being 
removing 

unwanted files”

Requirements
64-bit processor • OS X 10.9

Learn more
http://macpaw.com/cleanmydrive

Available from
Mac App Store

unwanted files”



89

There’s no denying that video streaming services 
such as Netflix and music services such as iTunes 
have transformed our Macs into our primary source 
of entertainment, almost consigning TVs and radios 
to the history books. However, the advantage your 
TV does have over a computer-based system is 
the ability to control it from a distance using the 
supplied remote control. And SiriMote brings the 
remote control to your Mac, provided you’ve got the 
Apple TV Remote to hand. 

All you have to do to be able to kick back and 
relax by watching your favourite shows or listen to 
your favourite music is follow this simple procedure. 
Download the free software, pair your Apple TV 
Remote to your Mac via your Bluetooth settings and 
within minutes you should be away. 

The program is very responsive and every click 
of the remote results in a near instantaneous 
response. It only works for certain entertainment 

programs, such as iTunes and QuickTime, so the 
basic functionality of the remote remains the same. 
The Play/Pause and volume control buttons on 
the remote perform the same function on the Mac. 
You can move forward and back through slides on 
Keynote or fast forward and rewind on VLC by using 
the touchpad and menu button. 

It’s really intuitive and it doesn’t take long to get 
the hang of using it on your Mac. The Bluetooth 
connection means that you can use SiriMote 
wherever and whenever you want, so you can 
benefit from it as much as you like.

We have to be honest and say it’s not quite 
perfect yet and it would be handy if you could 
use the trackpad to scroll through programs on 
your Mac or down your library, but hopefully that 
will come in a future update. For a free piece of 
software, it’s definitely worth getting if you have a 
remote already despite its limitations.

This is a pretty good piece of software and does exactly what is asked of it. 
We would like it to have a bit more functionality soon, though.

SiriMote
Free

Verdict

Match your Mac
Five of the media keys on your Mac 

keyboard have a corresponding 
button on the Apple Remote.

Long press
Pressing and holding the trackpad 
fast forwards. Pressing and holding 

Menu rewinds.

Bluetooth 4.0
The Apple TV remote will only 
connect if your Mac is running 

Bluetooth 4.0 or higher. 

3 Key Features

“The program is 
very responsive 
and every click 
of the remote 

results in a near 
instantaneous 

response”

SiriMote
Requirements

OS X 10.11 • Mac with Bluetooth 4.0
Learn more

www.eternalstorms.at
Available from

www.eternalstorms.at
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Familiar layout 
In case you find yourself a little 
confused, Patina shows you a 
quick tutorial upon first use.

Additional functions
Patina removes MS Paint’s fiddly 
colour picker, and has a handy 

slider to adjust brush size.

Quick image editing
Patina includes all you need to 

make basic image edits, but don’t 
expect anything advanced.

3 Key Features

“Patina fills 
the need of a 
basic drawing 

tool, with 
the design 

expected of a 
Mac app”

The exclusion of an integrated paint system in a 
Mac likely stems from the perception of it as a 
design platform made to run high-end digital editing 
programs: there’s seemingly no place for MS Paint 
on a system running the entire Adobe collection. 
But as Mac systems have steadily become more 
popular with non-designer users, that argument 
isn’t really the case anymore. Patina, developed 
by Atek, fills the need of a basic drawing tool for 
non-professionals, without losing the sleek design 
expected of a Mac app.

Anyone familiar with MS Paint will be comfortable 
using Patina; not only is the toolset similar, the 
layout is too. The drawing area takes up most of the 
display, with the toolbar on the left and accessible 
colour palettes at the bottom. The latter is a feature 
new to MS Paint alternatives, and the colour 
picker is easy to use, making Patina arguably more 
functional than its predecessors in this regard. 

Patina comes with all the standard tools offered 
by Paint: Brush, Pencil, Eraser, Text, Bucket, 
magnifying glass, and colour pipette. As would be 
expected of an MS Paint alternative, Patina can 
handle basic operations: drawing, annotations, 
manipulating shapes, picking and changing colours, 
moving and resizing objects, among others. 

However, Patina also comes with the caveats 
associated with basic painting tools. No more than 
one image can be opened at a time, which can 
stunt workflow. Users should also be aware that the 
Bucket tool is automatically set to anti-alias, and 
will produce sub-par results when filling alias lines. 
This can be fixed by disabling Smooth Edges under 
Preferences. But these limitations don’t detract from 
Patina’s intended purpose.

Patina is available to download for free, so this is 
a no-brainer for any user who wants to make quick 
and simple image edits. 

Patina is a paint program that Mac OS has been sorely lacking for a long time. 
It comes with all the drawbacks of MS Paint, but all of it conveniences too.

Patina
Free

Verdict

Requirements
OS X 10.8 and later • 64 bit processor

Learn more
www.patinaapp.com

Available from
Mac App Store
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Leo’s Fortune was a phenomenally 
successful platform puzzler on iOS and 
its arrival on the App Store has been 
eagerly anticipated. Guide the 

moustachioed bundle of fur across 24 levels of gold-
grabbing fun, dodging spikes, traps and solving 
some pretty fiendish puzzles along the way. 

The story follows the same path as the iOS game, 
with Leopold attempting to discover which of his 
relatives stole his valuable stash of gold, leaving him 
destitute. Following in the great footsteps of Mario 
and Sonic, you have to control Leo across a range 
of terrains tracking a trail of gold until you eventually 
catch up with the scoundrel that nicked his money.

The graphics on the HD version are simply 
wonderful and it was a joy to see it on the bigger 
screen where you can immerse yourself even further 
in the world. The locations for each level are varied 
enough and the difficulty curve at the right level to 

make this an enjoyable trek and fun game to play 
with the minimum of tutoring. It’s extremely intuitive 
and the kind of game that can be picked up swiftly 
by players of all ages. Most of the puzzles are 
logical but all require a degree of creative thinking 
that helps set it apart from endless runners or the 
gaming heavyweights mentioned earlier. 

Leo’s Fortune has made the transition from iOS 
to OS X very successfully and the game plays 
smoothly without lagging or jumping. There are 
hours of fun to be had here, picking up all the 
medals for making it though safely and in good time, 
ensuring this is a game that all the family can play 
and enjoy for a long time. 

Leo’s Fortune has struck gold with a game that is 
easy to pick up, challenging to play and brimming 
with fun puzzles and tests of dexterity. The Mac 
is the perfect platform for this platformer and we 
would highly recommend giving it a try.

We absolutely loved this adorable and charming game for its simple and engaging 
storyline and entertaining gameplay.

Leo’s Fortune
£4.99/$6.99

Verdict

Work your way across the maps, 
following the yellow coin road to 
discover who has your money

Earn trophies and rewards at the 
end of each level, depending on 

how well you performed 

There are hazards everywhere. He 
probably should have just put all 

that gold in an ISA

Going deeper underground, Leo 
has to battle plenty of landscapes 

in pursuit of his stash

Leo’s Fortune

“Guide the 
moustachioed 
bundle of fur 

across 24 
levels of gold-
grabbing fun”

We used
iMac (Mid 2011) • 4GB RAM • Intel graphics • Mouse and keyboard

Available from
Mac App Store

Requirements
OS X 10.8 • 2GB RAM • 1GB available space • OpenGL 2.0
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YOUR BONUS 
RESOURCES

ON OUR FILESILO SITE THIS 
ISSUE YOU WILL FIND AN 
UNMISSABLE COLLECTION OF 
CREATIVE RESOURCES 
•      All-new tutorial files to help you 

master this issue's Logic Pro X and 
iMovie projects

•      20 minutes of expert video guides 
from the brilliant MacMost team, 
including customising OS X icons

•      Two great, royalty-free fonts from our 
friends at SparkleStock

•      Five stock video clips 
•    Five awe-inspiring wallpapers to 

freshen up your Mac desktop 

total  resources

www.filesilo.co.uk/icreate
46

Tutorial files
This month's creative assets
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Stunning Mac wallpapers
Give your desktop a whole new lease of life

Expert video guides 
The hot topics explained in full
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The most popular downloads are shown 
in the carousel here, so check out what 
your fellow iCreate readers are enjoying! 

Green open padlocks show the 
issues you have accessed. Red closed 
padlocks indicate the ones you need to 
buy or unlock.

Find out more about our online stores, 
plus useful FAQs like our cookie and 
privacy policies and contact details. 

If you’re looking for a particular type of 
content like brushes or fonts, use the 
filters here to refine your search. 

Can’t find the resource you’re looking 
for in these filters? Click on More Options 
to specify exactly what kind of resource 
you want.

Top Downloads are listed here, so you 
can get an instant look at the most 
popular downloaded content. 

Check out the Highest Rated list to see 
the resources that other readers have 
voted for as the best! 

Discover our amazing sister magazines 
and the wealth of content and 
information that they provide.

The first time you use FileSilo you’ll need 
to register. After that, you can use the 
email address and password you 
provided to log in. 

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link 
on the following page. 

A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

DISCOVER YOUR FREE ONLINE ASSETS
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How to use
Everything you need to know about 
accessing your new digital repository 

GET IN TOUCH WITH 
iCREATE MAGAZINE

To access FileSilo, please visit www.filesilo.co.uk/icreate

01 Follow the 
instructions 

on screen to create an 
account with our secure 
FileSilo system. Log in 
and unlock the issue by 
answering a simple 

question about 
the magazine. 
You can access 
the content 
for free with 
your issue.

02 If you’re a print 
subscriber, 

unlock all the content by 
entering your unique 
Web ID. Your Web ID is 
the eight-digit 
alphanumeric code that 
is printed above your 
address details on the 
mailing label of your 
subscription copies. It 
can also be found on any 
renewal letters. 

03 You can access 
FileSilo on any 

computer, tablet or 
smartphone device using 
any popular browser 
(such as Safari, Firefox or 
Google Chrome). 
However, we 
recommend that you use 
a computer to download 
content, as you may not 
be able to download files 
to your phone or tablet. 

04 If you have any 
problems with 

accessing content on FileSilo, 
or with the registration 
process, take a look at the 
FAQs online or email 
filesilohelp@
imagine-publishing.co.uk.

To access FileSilo, please visit www.filesilo.co.uk/icreate
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For Mac, iPad and iPhone users

Time Machine

iSight webcam
Release date

23 June 2003
 

• Aluminium alloy • 30fps • FireWire connection 
Original price

£90/$149
Price now

£129.99/$139.95

Back in the days before cameras 
were embedded inside every phone 
and laptop, video calling could only 

take place with the help of an external 
webcam. However, they were all either 

grainy or horribly ugly. Then came along 
Apple with the gorgeous iSight. This 

blew all competition out of the water as 
it combined a sleek round chassis with 

an impressive – for the time – 30fps 
video capture. It was pricey and only 
worked seamlessly with iChat but the 

three mounting options, glorious design 
and top quality recording made this a 

classic piece of Apple hardware. 
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